
 

Part No. 209564-B
September 2002

4655 Great America Parkway
Santa Clara, CA 95054
Passport 8000 Series Switch 
Software Release 3.3

Using the 8683POSM Module
*209564-B*



2

 

Copyright © 2002 Nortel Networks

All rights reserved. September 2002.

The information in this document is subject to change without notice. The statements, configurations, technical data, and 
recommendations in this document are believed to be accurate and reliable, but are presented without express or implied 
warranty. Users must take full responsibility for their applications of any products specified in this document. The 
information in this document is proprietary to Nortel Networks NA Inc. 

Trademarks

Nortel Networks, the Nortel Networks logo, the Globemark, Unified Networks, Passport, and Alteon are trademarks of 
Nortel Networks.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation.

Adobe and Acrobat Reader are trademarks of Adobe Systems Incorporated.

SSH is a registered trademark and SSH Secure Shell is a registered trademark of SSH Communications Security Corp 
(www.ssh.com). The use of these trademarks is permitted to describe a product that conforms to the SSH standard and 
protocol. 

The asterisk after a name denotes a trademarked item.

Statement of conditions

In the interest of improving internal design, operational function, and/or reliability, Nortel Networks Inc. reserves the 
right to make changes to the products described in this document without notice.

Nortel Networks Inc. does not assume any liability that may occur due to the use or application of the product(s) or 
circuit layout(s) described herein.

International regulatory statements of conformity

This is to certify that the Nortel Networks 8000 Series chassis and components installed within the chassis were 
evaluated to the international regulatory standards for electromagnetic compliance (EMC) and safety and were found to 
have met the requirements for the following international standards:

• EMC - Electromagnetic Emissions – CISPR 22, Class A
• EMC - Electromagnetic Immunity – CISPR 24
• Electrical Safety – IEC 60950, with CB member national deviations

Further, the equipment has been certified as compliant with the national standards as detailed below.

National electromagnetic compliance (EMC) statements of compliance

FCC statement (USA only)

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of 
the Federal Communications Commission (FCC) rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy. If it is not installed and used in accordance with the instruction manual, it 
may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to 
cause harmful interference, in which case users will be required to take whatever measures may be necessary to correct 
the interference at their own expense.
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ICES statement (Canada only)

Canadian Department of Communications Radio Interference Regulations

This digital apparatus (8000 Series chassis and installed components) does not exceed the Class A limits for radio-noise 
emissions from digital apparatus as set out in the Radio Interference Regulations of the Canadian Department of 
Communications.

Règlement sur le brouillage radioélectrique du ministère des Communications

Cet appareil numérique (8000 Series chassis) respecte les limites de bruits radioélectriques visant les appareils 
numériques de classe A prescrites dans le Règlement sur le brouillage radioélectrique du ministère des Communications 
du Canada.

CE marking statement (Europe only)

EN 55 022 statements

This is to certify that the Nortel Networks 8000 Series chassis and components installed within the chassis are shielded 
against the generation of radio interference in accordance with the application of Council Directive 89/336/EEC. 
Conformity is declared by the application of EN 55 022 Class A (CISPR 22).

Warning: This is a Class A product. In a domestic environment, this product may cause radio interference, in which 
case, the user may be required to take appropriate measures.

Achtung: Dieses ist ein Gerät der Funkstörgrenzwertklasse A. In Wohnbereichen können bei Betrieb dieses Gerätes 
Rundfunkstörungen auftreten, in welchen Fällen der Benutzer für entsprechende Gegenmaßnahmen verantwortlich ist.

Attention: Ceci est un produit de Classe A. Dans un environnement domestique, ce produit risque de créer des 
interférences radioélectriques, il appartiendra alors à l’utilisateur de prendre les mesures spécifiques appropriées.

EN 55 024 statement

This is to certify that the Nortel Networks 8000 Series chassis is shielded against the susceptibility to radio interference 
in accordance with the application of Council Directive 89/336/EEC. Conformity is declared by the application of 
EN 55 024 (CISPR 24).

EC Declaration of Conformity

This product conforms to the provisions of the R&TTE Directive 1999/5/EC.

VCCI statement (Japan/Nippon only)

This is a Class A product based on the standard of the Voluntary Control Council for Interference (VCCI) for 
information technology equipment. If this equipment is used in a domestic environment, radio disturbance may arise. 
When such trouble occurs, the user may be required to take corrective actions.
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BSMI statement (Taiwan only)

This is a Class A product based on the standard of the Bureau of Standards, Metrology and Inspection (BSMI) CNS 
13438, Class A.

MIC notice (Republic of Korea only)

This device has been approved for use in Business applications only per the Class A requirements of the Republic of 
Korea Ministry of Information and Communications (MIC). This device may not be sold for use in a non-business 
application.
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National safety statements of compliance

CE marking statement (Europe only)

EN 60 950 statement

This is to certify that the Nortel Networks 8000 Series chassis and components installed within the chassis are in 
compliance with the requirements of EN 60 950 in accordance with the Low Voltage Directive. Additional national 
differences for all European Union countries have been evaluated for compliance. Some components installed within the 
8000 Series chassis may use a nickel-metal hydride (NiMH) and/or lithium-ion battery. The NiMH and lithium-ion 
batteries are long-life batteries, and it is very possible that you will never need to replace them. However, should you 
need to replace them, refer to the individual component manual for directions on replacement and disposal of the battery.

NOM statement (Mexico only)

The following information is provided on the devices described in this document in compliance with the safety 
requirements of the Norma Oficial Méxicana (NOM):

Exporter: Nortel Networks, Inc.
4655 Great America Parkway
Santa Clara CA 95054 USA

Importer: Nortel Networks de México, S.A. de C.V.
Avenida Insurgentes Sur #1605
Piso 30, Oficina
Col. San Jose Insurgentes
Deleg-Benito Juarez
México D.F. 03900 
Tel: 52 5 480 2100
Fax: 52 5 480 2199

Input: 100 to 240 VAC, 50 to 60 Hz, 12 A max. per power supply
–48 to –60 VDC, 29 A max. per power supply
single supply, two supply or two + one redundant supply configurations
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Información NOM (unicamente para México)

La información siguiente se proporciona en el dispositivo o en los dispositivos descritos en este documento, en 
cumplimiento con los requisitos de la Norma Oficial Méxicana (NOM):

Exportador: Nortel Networks, Inc.
4655 Great America Parkway
Santa Clara, CA 95054 USA

Importador: Nortel Networks de México, S.A. de C.V.
Avenida Insurgentes Sur #1605
Piso 30, Oficina
Col. San Jose Insurgentes
Deleg-Benito Juarez
México D.F. 03900 
Tel: 52 5 480 2100
Fax: 52 5 480 2199

Embarcar a: 100 to 240 V CA, 50 to 60 Hz, 12 A max. por fuente de poder
–48 to –60 V CD, 29 A max. por fuente de poder
una fuente, dos fuentes o dos + configuraciones de una fuente redundante

Nortel Networks Inc. software license agreement

This Software License Agreement (“License Agreement”) is between you, the end-user (“Customer”) and Nortel 
Networks Corporation and its subsidiaries and affiliates (“Nortel Networks”). PLEASE READ THE FOLLOWING 
CAREFULLY. YOU MUST ACCEPT THESE LICENSE TERMS IN ORDER TO DOWNLOAD AND/OR USE THE 
SOFTWARE. USE OF THE SOFTWARE CONSTITUTES YOUR ACCEPTANCE OF THIS LICENSE 
AGREEMENT. If you do not accept these terms and conditions, return the Software, unused and in the original shipping 
container, within 30 days of purchase to obtain a credit for the full purchase price.

“Software” is owned or licensed by Nortel Networks, its parent or one of its subsidiaries or affiliates, and is copyrighted 
and licensed, not sold. Software consists of machine-readable instructions, its components, data, audio-visual content 
(such as images, text, recordings or pictures) and related licensed materials including all whole or partial copies. Nortel 
Networks grants you a license to use the Software only in the country where you acquired the Software. You obtain no 
rights other than those granted to you under this License Agreement. You are responsible for the selection of the 
Software and for the installation of, use of, and results obtained from the Software.

1. Licensed Use of Software. Nortel Networks grants Customer a nonexclusive license to use a copy of the Software 
on only one machine at any one time or to the extent of the activation or authorized usage level, whichever is applicable. 
To the extent Software is furnished for use with designated hardware or Customer furnished equipment (“CFE”), 
Customer is granted a nonexclusive license to use Software only on such hardware or CFE, as applicable. Software 
contains trade secrets and Customer agrees to treat Software as confidential information using the same care and 
discretion Customer uses with its own similar information that it does not wish to disclose, publish or disseminate. 
Customer will ensure that anyone who uses the Software does so only in compliance with the terms of this Agreement. 
Customer shall not a) use, copy, modify, transfer or distribute the Software except as expressly authorized; b) reverse 
assemble, reverse compile, reverse engineer or otherwise translate the Software; c) create derivative works or 
modifications unless expressly authorized; or d) sublicense, rent or lease the Software. Licensors of intellectual property 
to Nortel Networks are beneficiaries of this provision. Upon termination or breach of the license by Customer or in the 
event designated hardware or CFE is no longer in use, Customer will promptly return the Software to Nortel Networks 
or certify its destruction. Nortel Networks may audit by remote polling or other reasonable means to determine 
Customer’s Software activation or usage levels. If suppliers of third party software included in Software require Nortel 
Networks to include additional or different terms, Customer agrees to abide by such terms provided by Nortel Networks 
with respect to such third party software.
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2. Warranty. Except as may be otherwise expressly agreed to in writing between Nortel Networks and Customer, 
Software is provided “AS IS” without any warranties (conditions) of any kind. NORTEL NETWORKS DISCLAIMS 
ALL WARRANTIES (CONDITIONS) FOR THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE AND ANY WARRANTY OF NON-INFRINGEMENT. Nortel Networks is not obligated to 
provide support of any kind for the Software. Some jurisdictions do not allow exclusion of implied warranties, and, in 
such event, the above exclusions may not apply.

3. Limitation of Remedies. IN NO EVENT SHALL NORTEL NETWORKS OR ITS AGENTS OR SUPPLIERS BE 
LIABLE FOR ANY OF THE FOLLOWING: a) DAMAGES BASED ON ANY THIRD PARTY CLAIM; b) LOSS OF, 
OR DAMAGE TO, CUSTOMER’S RECORDS, FILES OR DATA; OR c) DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS), 
WHETHER IN CONTRACT, TORT OR OTHERWISE (INCLUDING NEGLIGENCE) ARISING OUT OF YOUR 
USE OF THE SOFTWARE, EVEN IF NORTEL NETWORKS, ITS AGENTS OR SUPPLIERS HAVE BEEN 
ADVISED OF THEIR POSSIBILITY. The forgoing limitations of remedies also apply to any developer and/or supplier 
of the Software. Such developer and/or supplier is an intended beneficiary of this Section. Some jurisdictions do not 
allow these limitations or exclusions and, in such event, they may not apply.

4. General

a. If Customer is the United States Government, the following paragraph shall apply: All Nortel Networks 
Software available under this License Agreement is commercial computer software and commercial computer 
software documentation and, in the event Software is licensed for or on behalf of the United States 
Government, the respective rights to the software and software documentation are governed by Nortel 
Networks standard commercial license in accordance with U.S. Federal Regulations at 48 C.F.R. Sections 
12.212 (for non-DoD entities) and 48 C.F.R. 227.7202 (for DoD entities).

b. Customer may terminate the license at any time. Nortel Networks may terminate the license if Customer fails 
to comply with the terms and conditions of this license. In either event, upon termination, Customer must 
either return the Software to Nortel Networks or certify its destruction.

c. Customer is responsible for payment of any taxes, including personal property taxes, resulting from 
Customer’s use of the Software. Customer agrees to comply with all applicable laws including all applicable 
export and import laws and regulations.

d. Neither party may bring an action, regardless of form, more than two years after the cause of the action arose.

e. The terms and conditions of this License Agreement form the complete and exclusive agreement between 
Customer and Nortel Networks.

f. This License Agreement is governed by the laws of the country in which Customer acquires the Software. If 
the Software is acquired in the United States, then this License Agreement is governed by the laws of the state 
of New York.
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Preface

The 8683POSM Module is part of the Nortel Networks* 8000 Series line of 
communications products. This module is the Packet over SONET (POS) module 
for the 8000 chassis. This guide describes the features and operations of the 
8683POSM Module and provides instructions for installing and managing the 
module.

For a complete list of the documentation related to the Passport 8000 Switch 
Series Software Release 3.3, refer to the release notes for that release, or to the 
documentation CD provided with your software. Note that the Network Design 
Guidelines is a Web-posted document and will not be provided on your CD.

Before you begin

This guide is intended for network installers and system administrators who are 
responsible for installing, configuring, or maintaining networks. This guide 
assumes that you have the following background:

• Understanding of the transmission and management protocols used on your 
network

• Experience with windowing systems or graphical user interfaces (GUIs)
Using the 8683POSM Module
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Text conventions

This guide uses the following text conventions:

angle brackets (< >) Indicate that you choose the text to enter based on the 
description inside the brackets. Do not type the 
brackets when entering the command.
Example: If the command syntax is
ping <ip_address>, you enter
ping 192.32.10.12

bold Courier text Indicates command names and options and text that 
you need to enter.

Example: Use the dinfo command. 
Example: Enter show ip {alerts|routes}.

braces ({}) Indicate required elements in syntax descriptions where 
there is more than one option. You must choose only 
one of the options. Do not type the braces when 
entering the command.

Example: If the command syntax is
show ip {alerts|routes}, you must enter either
show ip alerts or show ip routes, but not both.

brackets ([ ]) Indicate optional elements in syntax descriptions. Do 
not type the brackets when entering the command.
Example: If the command syntax is
show ip interfaces [-alerts], you can enter
either show ip interfaces or 
show ip interfaces -alerts.

ellipsis points (. . . ) Indicate that you repeat the last element of the 
command as needed.

Example: If the command syntax is
ethernet/2/1 [<parameter> <value>]... ,
you enter ethernet/2/1 and as many
parameter-value pairs as needed.
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Hard-copy technical manuals

You can print selected technical manuals and release notes free, directly from the 
Internet. Go to the www.nortelnetworks.com/documentation URL. Find the 
product for which you need documentation. Then locate the specific category and 
model or version for your hardware or software product. Use Adobe* Acrobat 
Reader* to open the manuals and release notes, search for the sections you need, 
and print them on most standard printers. Go to Adobe Systems at the 
www.adobe.com URL to download a free copy of the Adobe Acrobat Reader.

You can purchase printed books and documentation sets from Vervante. To order 
printed documentation, go to Vervante at the www.vervante.com/nortel URL.

italic text Indicates new terms, book titles, and variables in 
command syntax descriptions. Where a variable is two 
or more words, the words are connected by an 
underscore.

Example: If the command syntax is
show at <valid_route>, valid_route is one
variable and you substitute one value for it.

plain Courier 
text

Indicates command syntax and system output, for 
example, prompts and system messages.
Example: Set Trap Monitor Filters

separator ( > ) Shows menu paths. 

Example: Protocols > IP identifies the IP command on 
the Protocols menu. 

vertical line ( | ) Separates choices for command keywords and 
arguments. Enter only one of the choices. Do not type 
the vertical line when entering the command.
Example: If the command syntax is
show ip {alerts|routes}, you enter either
show ip alerts or show ip routes, but not
both.
Using the 8683POSM Module
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How to get help

If you purchased a service contract for your Nortel Networks product from a 
distributor or authorized reseller, contact the technical support staff for that 
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact one of the following 
Nortel Networks Technical Solutions Centers:

Additional information about the Nortel Networks Technical Solutions Centers is 
available from the www.nortelnetworks.com/help/contact/global URL.

An Express Routing Code (ERC) is available for many Nortel Networks products 
and services. When you use an ERC, your call is routed to a technical support 
person who specializes in supporting that product or service. To locate an ERC for 
your product or service, go to the http://www.nortelnetworks.com/help/contact/
erc/index.html URL.

Technical Solutions Center Telephone

Europe, Middle East, and Africa (33) (4) 92-966-968

North America (800) 4NORTEL or (800) 466-7835

Asia Pacific (61) (2) 9927-8800

China (800) 810-5000
209564-B
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Chapter 1
8683POSM Modules concepts

The 8683POSM Module is a 128K records module which allows support for large 
layer 2 and layer 3 configurations. This module only operates with 8000 Series 
software release 3.3 and later. For 128K record support the following 
configurations are required:

• The chassis must include the 8691SF CPU module.

• All modules installed in the chassis must support 128K records running 3.3 
and later software.

• MMode (128K records mode) must be enabled. For instructions on enabling 
MMode (not a POS-specific command), see Platform and System 
Management.

The 8683POSM Module for the 8000 series routing switches provides WAN 
support to the 8000 Series product line by allowing access to SONET services in 
the metropolitan area. Where multiple campuses exist in a single metropolitan 
area, you can connect these campuses without compromising performance or 
increasing complexity. 

The 8683POSM Module is a baseboard with slots for three of the following two 
optional media dependent adapters (MDAs): 

• 1-port OC-12c/STM-4: single-mode fiber (SMF) or multimode fiber (MMF) 
using SONET/SDH

• 2-port OC-3c/STM-1: SMF or MMF using SONET/SDH

The 8683POSM Module supports up to six input/output (I/O) 
OC-3c/STM-1 lines and up to three I/O OC-12 lines. You can mix these MDAs on 
a single 8683POSM Module. For example, you can put an OC-12 MDA into the 
first slot and OC-3 MDAs into the two remaining slots. 
Using the 8683POSM Module
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You can put more than one 8683POSM Module in the 8000 series chassis, except 
slots 5 and 6, which are reserved for the 8691SF (Switch Fabric) modules. The 
maximum number of modules on a chassis is four. 

One 8691SF module acts as the CPU for the chassis, and the other module is the 
standby CPU, taking over in case of failure. If a CPU failover occurs, all traffic on 
the chassis stops momentarily while the standby CPU reinitializes all input/output 
modules.

For a complete discussion on the hardware specifics of your 8683POSM module, 
or on how to install you module, see Installing 8600 Switch Modules or the 
installation manual specific to your chassis.

Features

The 8683POSM Module has the following features:

• SONET and SDH compliant, supporting OC-3c/STM-1 and OC-12c/STM-4 
framing 

• Front-panel LEDs to monitor port activity and module operation

• Ability to remove and install a module (hot-swap) without resetting the switch 

• MTBF of 150,000 hours

• Internal and external loopback support on all ports for testing purposes

• Hardware diagnostics

• Brouter port configuration

• Bridging support: RFC 1638-compliant

• Routing support for both unicast and multicast IP and IPX routing

• Support for both single-mode fiber (SMF) and multimode fiber (MMF) 
cabling

• Support for DVMRP

• Support for IGMP

• Support for MultiLink Trunking (MLT)

• Support for the following VLAN features currently implemented in the 8000 
Series switch including:

— Port-based VLAN
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— Policy-based VLANs (protocol-based, IP subnet-based VLANs)

— IEEE 802.1Q tagged VLANs

• Support for the following RFCs:

— PPP over SONET: RFC 2615

— SONET/SDH: RFC 2558

— PPP: RFC 1471, RFC 1473, RFC 1474, and RFC 1661

— LQM: RFC 1989

— SNMP: RFC 1213

— IPCP: RFC 1332

— IPXCP: RFC1552

— BCP: RFC 1638_

• Multiple spanning tree groups - bridge mode only

• Manageable through the CLI or Device Manager, the SNMP-based graphical 
user interface

• Monitored through a World Wide Web browser from anywhere on the 
network

Switch fabric console port

Use the Console port on the switch fabric CPU (8691SF Module) to establish a 
local CLI or Device Manager session for the 8683POSM Module. For information 
on connecting to the Console port, refer to the appropriate installation manual for 
your 8000 Series chassis. 

The Diag port on the 8683POSM Module is used only by Nortel Networks 
personnel for debugging purposes. You can see diagnostic messages but you 
cannot input any text. 

The Diag port on the module is an RJ-45 port that allows out-of-band 
management by Nortel Networks personnel. 

A typical application consists of a single 8683POSM Module in an 8000 series 
switch, but multiple modules are also supported. 
Using the 8683POSM Module
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A typical network application of the 8683POSM Module is a direct connection 
between one 8000 series switch with a 8683POSM Module in one campus to an 
identical module in another 8000 series switch at another campus connected over 
a SONET ring. Using this connection, you achieve an intercampus link through 
packet over SONET (POS) technology.

SONET transmission

You can connect the 8683POSM Module through a Synchronous Optical Network 
(SONET) termination multiplexor to extend the range of the wide area network 
(WAN) connections. Or, you can connect the 8683POSM Module, using fiber, 
directly to a POS interface on another 8000 Series routing switch or on a 
traditional router.

The SONET frames received from the WAN contain IP packets encapsulated in 
Point-to-Point Protocol (PPP) that are converted by the 8683POSM Module into 
an Ethernet format. Similarly, the 8683POSM Module receives Ethernet frames 
and converts them into PPP packets for transmission over SONET.

SONET terms and acronyms

This section provides a brief listing of common Synchronous Optical Network 
(SONET) terms. SONET is a medium for transmitting data that uses fiber-optic 
cables. 

The following terms and acronyms are frequently used with SONET information:

• SONET: Synchronous Optical Network. SONET is a family of fiber optic 
transmission rates that provides the flexibility to transport many digital 
signals with different capacities. This ANSI standard provides for 
transmission from OC-1 to OC-48 and greater.

• SDH: Synchronous Digital Hierarchy. SDH is a standard technology for 
optical fiber-based synchronous data transmission. SDH is the international 
equivalent of SONET.

• OC-3c/STM-1: Optical Carrier-level 3 concatenation. OC-3c/STM-1 is an 
optical fiber transmission system that carries STS-3c/STM-1 frame structures 
at 155 Mb/s. Concatenation refers to the fact that there is only one logical data 
stream (rather than supporting a channelized structure).
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• OC-12c/STM-4: Optical Carrier-level 12 concatenation. OC-12c/STM-4 is an 
optical fiber transmission system that carries STS-12c/STM-4 frame 
structures at 622 Mb/s. Concatenation refers to the fact that there is only one 
logical data stream (rather than supporting a channelized structure).

• POS: Packet over SONET.

• PPP: Point-to-Point Protocol. PPP encapsulates common network-layer 
protocols in specialized Network Control protocol packets, such as IP over 
PPP (IPCP) and IPX over PPP (IPXCP), and BCP. Thus, it enables sending 
multiprotocol data over point-to-point links.

SONET/SDH transmission rates

The following transmission rates are commonly used with SONET:

• OC-3c/STM-1: 155.52 Mb/s 

• OC-12c/STM-4: 622.08 Mb/s 

The SONET specification defines optical both as:

• Single-mode fiber (SMF) 

• Multimode fiber (MMF).

Point-to-Point Protocol

The PPP family of protocols is divided into three categories:

• Control protocols control operation and maintenance of the PPP link.

• Network protocols describe the encapsulation methods needed to move 
multiprotocol network traffic over the PPP interface.

• Network control protocols are used to configure, manage, and control the 
operation of the network protocols. The 8683POSM Module uses the Link 
Control Protocol (LCP) and the Link Quality Report to monitor the link.

Note: The estimated maximum transmission distance for OC-3c SMF is 
20 kilometers (km); for OC-3c MMF is 2 km; for OC-12c SMF is 15 km; 
for OC-12c MMF is 500 m.
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PPP goes through the following basic initialization phases when bringing up links:

• Link establishment

• Network layer protocol

Establishing the PPP link

The Link Control Protocol (LCP) of the PPP helps establish a link. LCP generates 
three types of packets:

• Link configuration packets, including configure-request, configure-ACK, 
configure-NAK, and configure-reject packets

• Link termination packets, including terminate-request and terminate-ACK 
packets

• Link maintenance packets, including code-reject, protocol-reject, 
echo-request, and echo-reply packets

When two devices initialize a PPP dialog, each sends a configure-request packet 
to the other. Each configure-request packet contains a list of LCP options and 
corresponding values that the sending device uses to define its end of the link.

For example, a configure-request packet may specify the link’s maximum 
transmission unit (MTU) size. The configure-request packet contains the 
user-configured values, which the sending device and the receiving device may 
need to negotiate.

When the receiving device gets a configure-request packet from the sending 
device, the receiving device responds with one of the following three types of 
packets: 

• configure-ACK (that is, configure acknowledgment), 

• configure-reject, or 

• configure-NAK (that is, configure negative acknowledgment).

When the receiving device accepts the proposed LCP options, it responds with a 
configure-ACK packet. When the devices on each side of the link send and 
receive configure-ACK packets, the LCP advances to an open state, which means 
that the PPP interface can advance to the next phase. The devices converge.
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When the configure-request packet from the sending device contains options that 
the receiving device is not willing to negotiate, the receiving device sends back a 
configure-reject packet specifying the nonnegotiable options. From that point on, 
configure-request packets from the sending device should eliminate the 
unacceptable options. When the sending device eliminates the offending options, 
the devices converge.

When the receiving device disagrees with some or all of the values of the 
proposed options in the configure-request packet, it responds with a 
configure-NAK packet. The configure-NAK packet notes the values that the 
receiving device disagrees with, and it includes the corresponding values that the 
receiving device would like to see in subsequent configure-request packets.

LCP negotiations between sending and receiving devices continue until either:

• Both devices converge (reach an agreement regarding the configure-request).

• The receiving device transmits a specified number of configure-NAK packets 
before sending a configure-reject packet.

• The convergence timer expires.

Negotiating network layer protocols

PPP uses various network control protocols to determine the values of parameters 
during network layer negotiations, which is the final phase of PPP initialization. 
Similar to the LCP, each network control protocol allows the devices to negotiate 
various network options over the data link by transmitting configure-request, 
configure-ACK, configure-NAK, and configure-reject packets.

Networks options include which network addresses to use and which media types 
to bridge. Once both devices agree upon networks options, the network control 
protocol reaches the open state. The devices then begin transmitting user data 
packets for upper-layer protocols over the link.
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Packet-over-SONET

Packet-over-SONET (POS) is a transport system that carries IP packets directly 
over a SONET/SDH network without any data link facility, such as ATM, in 
between. POS transmits information at the highest rates possible, because SONET 
has a smaller packet header overhead than ATM (28 bytes out of an 810-byte 
frame compared with 5 out of a 53-byte ATM cell). 

On a 8683POSM Module, the following features and protocols are supported:

• Three types of VLANs are supported:

— Port-based VLANs

— Protocol-based VLANs

— 802.1q VLANs

• The Spanning Tree Protocol (STP) and FastStart are supported. The Bridge 
Protocol Data Unit (BPDU) format is enabled by default on the 8683POSM 
Module. It must be disabled if support for spanning tree groups is required.

• MultiLink Trunking (MLT)

• Internet Group Management Protocol (IGMP) 

• Distance Vector Multicast Routing Protocol (DVMRP)

• Point-to-Point Protocol (PPP)

PPP over SONET

Point-to-point protocol connections over SONET are supported. Because the PPP 
encapsulation has relatively low overhead, higher throughput can be attained 
compared to other SONET/SDH payload mapping, at a lower cost for line 
termination equipment.

Since SONET/SDH is by definition a point-to-point circuit, PPP is appropriate to 
use over these connections.

Physical layer requirements

PPP treats SONET/SDH transport as octet-oriented synchronous links. SONET/
SDH links are full-duplex mode by definition. 
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Interface format

PPP presents an octet interface to the physical layer. There is no provision for 
suboctets to be supplied or accepted.

The octet stream is mapped into the SONET/SDH Synchronous Payload Envelope 
(SPE), with the octet boundaries aligned with the SPE octet boundaries.

No scrambling is needed during insertion into the SPE. The Path Signal Label 
(C2) is intended to indicate the contents of the SPE. The experimental value of 
207 is used to indicate PPP. 

The Multiframe Indicator (H4) is currently unused, and must be zero.

Transmission rate

The basic rate for PPP over SONET/SDH is that of STS-3c/STM-1 at 155.520 
Mb/s. The available information bandwidth is 149.760 Mb/s, which is the STS-3c/
STM-1 SPE with section, line, and path overhead removed. 

Control signals

PPP does not require the use of control signals. When available, using such 
signals can allow greater functionality and performance. 

Frame format

Figure 1 presents a summary of the PPP HDLC frame structure. It does not 
include start/stop bits (for asynchronous links), nor any bits or octets inserted for 
transparency. The fields are transmitted from left to right.
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Figure 1   PPP HDLC frame structure

Flag Sequence

The Flag Sequence indicates the beginning or end of a frame and always consists 
of the binary sequence 01111110 (hexadecimal 0x7e). 

The Flag Sequence is a frame separator. Only one Flag Sequence is required 
between two frames. Two consecutive Flag Sequences constitute an empty frame, 
which is ignored and not counted as an FCS error. 

Address field 

The Address field is a single octet and contains the binary sequence 11111111 
(hexadecimal 0xff), the All-Stations address. PPP does not assign individual 
station addresses. The All-Stations address must always be recognized and 
received. The use of other address lengths and values may be defined at a later 
time or by prior agreement. Frames with unrecognized addresses should be 
silently discarded. 

Control field 

The Control field is a single octet and contains the binary sequence 00000011 
(hexadecimal 0x03), the Unnumbered Information (UI) command with the P/F bit 
set to zero. The use of other Control field values may be defined at a later time or 
by prior agreement. Frames with unrecognized Control field values should be 
silently discarded. 
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Frame Check Sequence (FCS) field 

The Frame Check Sequence field is normally 16 bits (two octets). The use of other 
FCS lengths may be defined at a later time or by prior agreement. The FCS is 
transmitted with the coefficient of the highest term first. 

The FCS field is calculated over all bits of the Address, Control, Protocol, 
Information and Padding fields, not including any start and stop bits 
(asynchronous) nor any bits (synchronous) or octets (asynchronous or 
synchronous) inserted for transparency. This field also does not include the Flag 
Sequences nor the FCS field itself. 

Configuration details

The standard LCP sync configuration defaults apply to SONET/SDH links. 

The following configuration options are recommended:

• Magic Number

• No Address and Control Field Compression

• No Protocol Field Compression

• 32-bit FCS

PPP Bridging Control Protocol (BCP)

The PPP BCP is supported. This protocol allows BPDUs to be transmitted over 
the POS link. When multiple spanning tree groups are used, the STP feature is 
disabled and BPDUs are bridged using the bridged coding. 

Note: When octets are received and flagged in the Async- Control-
Character-Map, they are discarded before calculating the FCS.
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Spanning tree group feature

The BPDU (Bridge Protocol Data Unit) format specified in RFC 1638 is enabled 
by default on the 8683POSM Module. If support for multiple spanning tree 
groups is required, the BPDU default format must first be disabled. For 
information on changing the STG format, see “config pos ppp” on page 79.
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Chapter 2
Configuration considerations and limitations

This chapter describes configuration limitations and considerations and 
interoperability issues that you should consider when configuring your 
8683POSM Module. 

Device Manager access and passwords

Table 1 shows the security access levels for the 8683POSM Module.

Table 1   8683POSM Module access levels

Level of Access 8683POSM Module feature

Level 1 (read/write) SONET parameters

Level 2 (read/write) All PPP bridging and Spanning Tree parameters

Level 3 (read/write) All IP and IPX routing parameters
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Port numbering

You must insert an MDA into the 8683POSM Module in order to have 
connectivity. The module contains three slots for MDAs, and you can mix and 
match from among the following MDAs, which are available (SMF and MMF):

• 1-port OC-12c/STM-4

• 2-port OC-3c/STM-1

The management system identifies an interface by its slot number in the 8000 
series chassis and its port number, using the syntax slot number/port number (s/p). 
Because the 8683POSM Module can have up to six ports with three 2-port MDAs 
inserted, port numbers 1 and 2 are reserved for the MDA in the left slot regardless 
of the actual physical number of ports. Port numbers 3 and 4 apply to the MDA in 
the middle slot regardless of the actual physical number of ports; and port 
numbers 5 and 6 apply to the MDA in the right slot regardless of the physical 
number of ports.

For example, a 8683POSM Module in the second slot of the 8000 series chassis 
with an OC-12c/STM-4 MDA in the left slot, an OC-3c/STM-1 MDA in the 
middle, and an OC-12c/STM-4 MDA in the right slot has the following port 
numbers for management and configuration:

• 2/1: OC-12c/STM-4

• 2/3: OC-3c/STM-1, left port

• 2/4: OC-3c/STM-1, right port

• 2/5: OC-12c/STM-4

As another example of port numbering, an 8683POSM Module in the second slot 
of the chassis with an OC-3c/STM-1 MDA in the left slot, the middle slot blank, 
and an OC-12c/STM-4 installed in the right slot has the following port numbers:

• 2/1: OC-3c/STM-1, left port

• 2/2: OC-3c/STM-1, right port

• 2/5: OC-12c/STM-4

A 8683POSM Module with three OC-3c/STM-1 MDAs installed has ports 
numbered consecutively 1 through 6, from left to right.
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IPX encapsulation method

When a POS port is configured for IPXCP (IPX routed link), the only 
encapsulation method that you can use is Ethernet II. For more information, see 
“Configuring IPX routing” on page 54.

Rebooting a terminal connected to the diagnostic port

Rebooting a terminal connected to the Diagnostic port on the Passport 8683POS 
module may cause the module to reset. This port is intended only for debugging 
operations and should not be used during normal operation.

Severely Errored Seconds

In a statistics display, a Severely Errored Second (SES) is a second where x or 
more Coding Violations occur. The value of x is dependent on the bit rate as 
follows:

Table 2 shows the value of x for the available Bit Rates 

Table 2   Value of x for available Bit Rates

Bit Rate x value for Coding Violations

OC-3 155

OC-12 616
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Chapter 3
Configuring the 8683POSM Module Using Device 
Manager

Two management tools enable you to configure the 8683POSM Module: Device 
Manager and command line interface (CLI). You can also use the embedded 
web-based management feature to monitor the 8683POSM Module. See 
Chapter 5, “Web management,” on page 115 for information on using the 
web-based management feature.

Device Manager is an SNMP-based graphical user interface tool designed to 
manage single devices. In order to use Device Manager, you must have network 
connectivity to a management station running Device Manager on one of the 
supported platforms. This section describes Device Manager features that are 
specific to the 8683POSM Module.

For detailed information on all aspects of installing and running Device Manager, 
refer to Getting Started with the 8000 Series Management Software.

This chapter describes the following topics:

Topic Page

Configuring and managing POS 38

Configuring the SONET trap feature 57

Viewing the Trap Log 60

SONET loopback test feature 61

Viewing 8683POSM statistics 62
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Configuring and managing POS

This section describes how to use Device Manager to configure and manage POS, 
and includes the following topics:

• “Default 8683POSM configuration, next

• “Changing default settings” on page 39,” next

• “Resetting the 8683POSM Module” on page 43”

• “Viewing MDA information” on page 45”

• “Enabling or disabling a port” on page 46”

• “Configuring SONET parameters” on page 47”

• “Configuring bridging” on page 50”

• “Configuring routing” on page 50”

You can configure the 8683POSM Module in two basic modes: 

• Bridging: Bridging mode is enabled by default. Bridging is configured for 
connections between two 8683POSM Modules and between 8683POSM 
Modules and other devices that support PPP bridging.

• Routing: You select routing mode for connections between your 8683POSM 
Module and other POS-capable routers for IP and IPX routing.

Default 8683POSM configuration

Table 3describes the default 8683POSM Module configuration. 

Table 3   8683POSM Module default settings  

Parameter Default

Bridge Admin State (BCP) Open

IP Admin State (IPCP) Close

IPX Admin State (IPXCP) Close

Clock source Line 

FCS size 32

Debug Disabled

Framing SONET
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Changing default settings

To change the default settings on the 8683POSM Module or to perform any 
configuration tasks in Device Manager, select the port you want to configure and 
open the Interface tab.

To open the Interface tab:

• Right-click on the port. A shortcut menu opens. Choose Edit.

• Double-click on the port.

The Port dialog box opens with the Interface tab displayed (Figure 2). 

Priority Low 

Lock False

Lqr interval 100

Lqr status Enabled 

Lqr threshold 95

Magic number True

Oversize frame Disabled 

Perform tagging Disabled

Scramble Enabled

Signal-Label (C2) 0x16

Section trace (J0) 1 (0x01)

STP RFC 1638 Enabled 

Tagged frame discard Disabled

Unknown MAC discard Disabled

Untagged frame discard Disabled

Device Manager interval 10 seconds

Do one of the following:

Table 3   8683POSM Module default settings (continued) 

Parameter Default
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Figure 2   Port dialog box — Interface tab
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Table 4 describes the Interface tab fields.

Table 4   Interface tab fields

Fields Description

Index Unique value assigned to each interface. The value ranges between 
16 and 255. 

Name Displays the name of this port. To assign or change a name to the port, 
highlight the field and enter alphanumeric characters.

Descr Type of interface, either:

• OC-3c MMF or SMF

• OC-12c MMF or SMF

Type Media type of this interface. This will be ppp for a port on the 
8683POSM Module.

Mtu Size (in octets) of the largest packet that can be sent or received on 
the interface. For IPCP and IPXCP, the maximum is 1936. When BCP 
is enabled, however, the maximum is 1934. Check which NCP is 
enabled before configuring the Mtu on a connecting device.

Note: The Bridge Control Protocol (BCP) is enabled on the 
8683POSM Module by default. 

PhysAddress MAC address assigned to a particular interface.

VendorDescr Vendor description.

AdminStatus Sets the port to one of the following states:

• up

• down

• testing

When a managed system initializes, all interfaces start with 
AdminStatus in the down state. As a result of either management or 
configuration action, the AdminStatus is changed to the up state (or 
remains in the down state). The testing state indicates that no 
operational packets can be passed. 
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OperStatus Operational state of the interface, one of the following:

• up

• down

• testing

The testing state indicates that no operational packets can be passed. 
If AdminStatus is down, then OperStatus should be down. 
If AdminStatus is changed to up, then OperStatus should change to up 
if the interface is ready to transmit and receive network traffic. 
It should remain in the down state if and only if there is a fault that 
prevents it from going to the up state.

LastChange Value of sysUpTime at the time the interface entered its current 
operational state. If the current state was entered prior to the last 
reinitialization of the local network management subsystem, the value 
is zero.

LinkTrap Sets whether or not link Up/link Down traps should be generated for 
this interface.

• enabled—sends traps for link up or down

• disabled—does not send traps for link up or down

OperDuplex Current operational duplex of the port (half or full). This will always be 
full duplex on a POS port.

OperSpeed Current operating speed of the port. It can be either 155 or 622 Mb/s 
depending on the type of interface installed.

MultiMediaPlatfo
rmAndDevice

Opens a dialog box that allows you to select the platform and device 
for multimedia.

TelephonyAnd
MultiMediaFilter
Enable

Enables IP telephony and multimedia filters.

MltId Multi-Link Trunk to which the port is assigned (if any).

Locked Displays whether or not the port is locked. When locked, the port 
configuration cannot be changed. To lock or unlock a port, select Edit 
> Security > Port Lock.

Action Sets one of the following port-related actions:

• none

• flushMacFdb—flush MAC forwarding table for port

• flushArp—flush ARP table for port

• flushIp—flush IP route table for port

• flushAll—flush all tables for port

• triggerRipUpdate—manually update the RIP table

Result Displays results from the last system action.

Table 4   Interface tab fields (continued)

Fields Description
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From the Interface tab, select other POS-specific tabs to configure the port or 
change current or default configurations.

Resetting the 8683POSM Module

To reset 8683POSM module: 

1 Highlight the card. 

2 Choose Edit > Card. 

The Card dialog box opens with the Card tab displayed (Figure 3).

Figure 3   Card tab 

Table 5 describes the fields in the Card tab.
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3 Click the POS tab. 

The POS tab opens (Figure 4).

Figure 4   POS tab 

Table 6 describes the fields in the POS tab

Table 5   Card tab fields

Field Description

FrontType Card type.

FrontDescription Packet Over Sonet.

FrontAdminStatus The administrative status of the card.

FrontOperStatus The operational status of the card.

FrontSerialNum Serial number of card.

FrontHwVersion Hardware version.

FrontPartNumer Part number.

FrontDateCode Date code.

FrontDeviations Deviations.

BackType Card back type.

BackDescription Description.

BackSerialNum Serial Number.

BackHwVersion Hardware version.

BackPartNumer Part number.

BackDateCode Date code.

BackDeviations Deviations.
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.

4 Click reset.

5 Click Apply.

Viewing MDA information

To view information on the MDA you are using:

1 Highlight the MDA.

2 Select Edit > Mda.

The MDA dialog box opens (Figure 5).

Figure 5   MDA dialog box 

Table 6   POS tab fields

Field Description

Action: reset Resets the card.

ImageFileName Name of the image file which downloads at initialization.
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Table 7 describes the fields in the MDA dialog box.

Enabling or disabling a port

You can enable or disable a port by two methods. To enable or disable a port 
through the Device Manager menu bar:

1 Highlight the port. 

2 From the Device Manager menu bar, choose Edit > Port. 

The Port dialog box opens with the Interface tab displayed (Figure 2 on 
page 40).

3 In AdminStatus area, click up to enable the port, or click down to disable the 
port.

4 Click Apply.

To enable or disable a port using a shortcut menu:

Table 7   MDA dialog box fields

Field Description

Type Media type:

• OC-3c SMF MDA

• OC-3c MMF MDA

• OC-12c SMF MDA

• OC-12c MMF MDA

Description MDA description:

• OC-3c SMF MDA—Dual port OC-3c SMF

• OC-3c MMF MDA—Dual port OC-3c MMF

• OC-12c SMF MDA — Single Port OC-12c SMF 

• OC-12c MMF MDA —Single Port OC-12c MMF

Note: When you change configurations in Device Manager, and click 
the Apply button, the system will disable and re-enable the port 
automatically.
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1 Right-click on the port.

A shortcut menu opens.

2 Choose Enable or Disable. 

Configuring SONET parameters

To change the default parameters, you configure the values for the Synchronous 
Optical Network (SONET) media in the POS SONET tab. These values must be 
configured before you configure POS PPP, VLAN, or any other parameters. 

See Table 3 on page 38 for the default SONET parameters.

To change the configuration of the SONET parameters:

1 Highlight the port. 

2 Choose Edit > Port. 

The Port dialog box opens with the Interface tab displayed (Figure 2 on 
page 40).

3 Disable the port as described in “Enabling or disabling a port” on page 46. 

4 In the Interface tab, click the POS SONET tab.

The POS SONET tab opens (Figure 6).
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Figure 6   Port dialog box — POS SONET tab

Table 8 describes the fields in the POS SONET tab.

Table 8   POS SONET tab fields

Field Description

SonetFraming Sets the framing for the port to:

• SONET—Synchronous Optical Network format; 
standard format used in North America (default)

• SDH—Synchronous Digital Hierarchy clock 
format; standard format used in Europe.

SonetOperStatusFraming Operational value of SONET framing.

SonetSectionTrace Sets the integer that the section trace flag (j0) is set 
to, that is an integer between 1 and 255.

SonetOperStatusSectionTrace Operational value of SonetSectionTrace.

SonetOperStatusPathSignalLabel Operational value of Path Signal Label.

SonetClockSource Sets the Clock Source to either line or internal.
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5 Select the SonetClockSource, either line or internal.

If two POSM Modules are operating directly (that is, connected back to back, 
without any intervening Sonet equipment), one port must provide the clock 
source. Set the clock source of one port to internal, and the opposite port must 
be set to line. 

6 Select other SONET parameters.

7 Click Apply.

8 Re-enable the port as described in “Enabling or disabling a port” on page 46.

SonetOperStatusClockSource Operational value of ClockSource.

SonetScramble Parameter that enables or disables the scrambling 
option.

SonetOperStatusScramble Operational value of SonetScramble.

SonetMedium

MediumType Identifies whether a SONET or a SDH signal is 
used across this interface.

MediumTimeElapsed Number of seconds, including partial seconds, that 
have elapsed since the beginning of the current 
measurement period. If, for some reason, such as 
an adjustment in the system’s time-of-day clock, the 
current interval exceeds the maximum value, the 
agent will return the maximum value.

MediumValidIntervals Number of previous 15-minute intervals for which 
data was collected.

MediumLineCoding Line coding for this interface. The Non-Return to 
Zero (NRZ) line coding is used for optical SONET/
SDH signals.

MediumLineType Line type for this interface. The line types are single 
mode fiber or multimode fiber interfaces. 

MediumCircuitIdentifier Transmission vendor’s circuit identifier, for the 
purpose of facilitating troubleshooting. Note that the 
circuit identifier, if available, is also represented by 
ifPhysAddress.

Table 8   POS SONET tab fields (continued)

Field Description
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Configuring bridging

The 8683POSM Module is configured for bridging by default. The configuration 
is set for bridging between two 8683POSM Modules with one default VLAN. The 
Bridge Control Protocol (BCP) is enabled on the 8683POSM Module by default.

You can also configure bridging for the 8683POSM Module for connection to 
other POS-capable devices.

Configuring routing 

A POS port configured for IPCP and/or IPXCP encapsulation must be the sole 
member of the VLAN. You cannot add any other port to a VLAN which already 
has a POS port with IPCP and/or IPXCP encapsulation enabled. You cannot add a 
POS port which is configured for IPCP and/or IPXCP encapsulation to a VLAN 
which already has other ports as members.

Configuring IP routing

To configure the 8683POSM Module for IP routing using Device Manager: 

1 Highlight the port.

2 Choose Edit > port.

Note: When the POS link is enabled after a parameter change or a 
chassis reset, some superfluous traffic may initially be sent out of POS 
ports before any LCP packets go out. This is normal.

Note: When the 8600 switch is interoperating with a Juniper router, the 
POS port must have the Juniper IP address configured in the remote IP 
field. This is necessary because the Juniper routers do not provide their 
local IP address during PPP negotiation. The 8600 switch requires the 
Juniper address for IPCP operations. 

Note also that for the IP address assigned to the POS port, 30-bit subnet 
masks may be required for certain JUNOS releases.
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The Port dialog box opens with the Interface tab displayed (Figure 2 on 
page 40).

3 Click the POS PPP tab.

The POS PPP tab opens (Figure 7).

Figure 7   Port dialog box — POS PPP tab
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Table 9 describes the POS PPP tab fields.

4 In the BridgeConfigAdminStatus section, click close to disable bridging. 

Table 9   POS PPP tab fields

Area Field Description

Link LinkConfigMagicNumber If set to enable, selects a random number (“magic number”) 
used in loopback detection. Enable detects loopback; disable 
does not detect loopback. 

OperStatusLinkMagicNumber Operational value of LinkConfigMagicNumber.

LinkConfigFcsSize Configures the size (in bits) of cyclic redundancy check field 
used in PPP frame.

LinkStatusTransmitFcsSize Operational value of LinkConfigFcsSize.

Bridge BridgeAdminConfigStatus This parameter enables or disables bridged traffic with in 
PPP.

BridgeOperStatus Operational value of BridgeAdminConfigStatus.

LineConfigPppStp Enables BPDUs to be received or transmitted with BPDU 
specific encapsulation. When disabled encapsulated within 
Ethernet frames.

OperStatusLinePppStp Operational value of LineConfigPppStp.

IP IpConfigAdminStatus Enables or disables the IP traffic (link) with in PPP.

IpOperStatus Operational value of IP link.

LineConfigRemoteIPAddr Configured value of remote end IP address.

LineStatusRemoteIPAddr Negotiated value of the remote end IP address.

IPX IpxcpAdminStatus Enables or disables the IPX traffic (link) with in PPP.

IpxOperStatus Operational value of IPX link.

RoutingProtocol Sets the IPX Routing Protocol to none or RIP.

LineStatusIpxRoutingProtocol Negotiated value of RoutingProtocol.

LQR LqrConfigStatus Sets the link quality reporting to enabled or disabled. 

OperStatusLqrStatus Negotiated value of LqrConfigStatus.

LqrConfigPeriod Sets the link quality-reporting interval in 100th of a second.

LineStatusLocalPeriod Negotiated value of LqrConfigPeriod.

LineConfigLqrThreshold Sets input quality threshold in percent.

OperStatusLqrThreshold Operational value of LineConfigLqrThreshold.
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5 To enable IP routing, in the IpConfigAdminStatus field, click open.

6 To configure an IP address for the port:

a Highlight the port. 

b Choose Edit > Port. 

The Port dialog box opens with the Interface tab displayed (Figure 2 on 
page 40).

c Click the IP Address tab.

The IP address tab opens (Figure 8).

Figure 8   Port dialog box — IP Address tab

Table 10 describes the fields in the IP Address tab.

d Click Insert. 

Table 10   IP Address tab fields

Field Description

IpAddress IP address to which the entry's addressing information pertains.

NetMask The subnet mask associated with the IP address of the entry.

BcastAddrFormat The IP broadcast address format used on this interface.

ReasmMaxSize The size of the largest IP datagram which this entity can 
re-assemble from incoming IP fragmented datagrams received on 
this interface. 

VlanId Unique VLAN identifier.

BrouterPort indicates whether this entry corresponds to a brouter port (as 
oppose to a routable VLAN). This value cannot be changed after 
the row is created.
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The Port, Insert IP Address dialog box opens (Figure 9).

Figure 9   Port, Insert IP Address dialog box

Table 11 describes the Port, Insert IP Address dialog box fields.

e Type the IP address and click Insert.

The IP address displays in the table in the IP Address tab (Figure 8).

7 Click Apply.

8 To enable the port on the 8683POSM Module, click the Interface tab and, in 
the AdminStatus field, click up.

9 Click Apply.

Configuring IPX routing

When you use IPXCP encapsulation, you must select Ethernet II as the MAC 
encapsulation for the protocol-based VLANs. IPXCP supports only the Ethernet 
II format.

To configure the 8683POSM Modules for IPX routing using Device Manager, you 
must configure an Ethernet II protocol-based VLAN.

Table 11   Insert IP Address dialog box fields

Fields Description

Ip Address IP address to which the entry's addressing information pertains.

Net Mask The subnet mask associated with the IP address of the entry.

VlanId Unique VLAN identifier.
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1 Highlight the port.

2 Choose Edit > port.

The Port dialog box opens with the Interface tab displayed (Figure 2 on 
page 40).

3 Disable the port as described in “Enabling or disabling a port” on page 46. 

4 To configure the VLAN as an IPX protocol-based VLAN and assign the port 
to the VLAN:

a From the Device Manager menu bar, choose VLAN > VLAN.

The VLAN dialog box opens with the Basic tab displayed (Figure 10). 

Figure 10   VLAN dialog box — Basic tab 

Table 12 describes the fields in the Basic tab.

Table 12   Basic tab fields

Field Description

Id Unique VLAN identifier.

Name An administratively-assigned name for this VLAN.

ColorIdentifier An administratively-assigned color code for this VLAN. The value 
of this object is used by the VLAN Manager GUI tool to select a 
color when it draws this VLAN on the screen.

Type Type of VLAN, distinguished according to the policy used to 
define its port membership. 

StgId Spanning Tree Group (STG) used by the VLAN to determine the 
state of its ports. If the VLAN is not associated with any STG, this 
value should be set to zero.
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b To assign the POS ports to the VLAN as static members, enter the ports in 
the StaticMembers column.

c To assign all other ports to the VLAN as active members, enter the ports 
in the ActiveMembers column.

d Click Apply.

5 To disable bridging:

a Click the POS PPP tab.

b In the Bridge area, BridgeConfigAdminStatus field, click Close. 

6 To enable IPX routing on each selected port:

a Click the POS PPP tab.

b In the IPX area, IpxcpAdminStatus field, click Open.

7 To enable the port on the 8683POSM Module:

a Click the Interface tab.

b In the AdminStatus field, click Up.

PortMembers Set of ports that are members (static or dynamic) of this VLAN. 

ActiveMembers Set of ports that are currently active in this VLAN. Active ports 
include all static ports and any dynamic ports where the VLAN 
policy was met.

StaticMembers Set of ports that are static members of this VLAN. A static 
member of a VLAN is always active and is never aged out.

NotAllowtoJoin Set of ports that are not allowed to become members of this 
VLAN.

ProtocolId Protocol identifier of this VLAN. This value is meaningful only if 
rcVlanType is equal to byProtocolId(3). For other VLAN types it 
should have the value none(0). 

SubnetAddr IP subnet address of this VLAN. This value is meaningful only if 
rcVlanType is equal to byIpSubnet(2). For other VLAN types it 
should have the value 0.0.0.0. 

SubnetMask IP subnet mask of this VLAN. This value is meaningful only if 
rcVlanType is equal to byIpSubnet(2). For other VLAN types it 
should have the value 0.0.0.0.

Table 12   Basic tab fields (continued)

Field Description
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8 Click Apply.

Configuring the SONET trap feature

The 8600 chassis with a functioning 8683POSM Module automatically transmits 
SONET-specific traps. 

To configure the device for SONET-specific traps:

1 In Device Manager, select the chassis.

The frame of the chassis is highlighted.

2 Choose Edit > Chassis.

The Chassis dialog box opens with the System tab displayed (Figure 11).
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Figure 11   Chassis dialog box — System tab

3 Click the Trap Receivers tab.

The Trap Receivers tab opens (Figure 12).

Figure 12   Chassis dialog box — Trap Receivers tab
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Table 13 describes the fields in the Trap Receivers tab.

4 Click Insert.

The Chassis, Insert Trap Receivers dialog box opens (Figure 13). 

Figure 13   Chassis, Insert Trap Receiver dialog box

Table 14 describes the fields in the Insert Trap Receiver dialog box.

5 Enter the IP address of the device where traps are to be sent and click Insert.

The dialog box closes and the Trap Receivers tab is redisplayed.

6 Click Apply.

Table 13   Trap Receivers tab fields

Field Description

IpAddress IP address of the device used to capture traps.

Community Community string used for trap messages to this trap receiver.

Version Version

Table 14   Insert Trap Receiver dialog box fields

Field Description

IpAddress IP address of the device used to capture traps.

Community Community string used for trap messages to this trap receiver

Version Version 
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Viewing the Trap Log

To view the Trap Log that contains SONET-specific traps:

The Trap dialog box opens (Figure 14).

Figure 14   Trap Log dialog box

Table 15 describes the fields in the Trap Log dialog box.

Click the bell icon on the toolbar.

Table 15   Trap Log dialog box fields

Field Description

Node IP address of the device sending SONET trap.

Time Timestamp in the trap.

Type Type of SONET trap: Section/Line/Path alarm.

Description Description of the alarm: LOS, LOF, and so forth.
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SONET loopback test feature

This section describes the loopback test features in Device Manager available for 
the 8683POSM Module. For information on the CLI test commands, see “Using 
the test commands” on page 112

To test for loopback:

1 Highlight the port.

2 Choose Edit > port.

The Port dialog box opens with the Interface tab displayed (Figure 2 on 
page 40).

3 In the AdminStatus field, click testing.

4 Click Apply.

5 Click the Test tab.

The Test tab opens (Figure 15).

Figure 15   Port dialog box — Test tab 

Table 16 describes the Test tab fields.

Note: All ports must be in test mode to conduct any testing. 
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Table 16   Test tab fields

6 Click Ext. Loopback to test the external loopback or click Int. Loopback to 
test the internal loopback.

A dialog box displays the test results.

7 Click Stop to cease testing.

8 Click Close.

9 Click the Interface tab.

10 In the AdminStatus field, click up.

11 Click Apply.

The test statistics are available only when the test has finished, unlike Ethernet 
ports where the test statistics can be viewed during testing.

Viewing 8683POSM statistics

Device Manager allows you to graph and display certain read-only statistics for 
the 8683POSM Module.

The 8683POSM Module provides the following read-only statistics tabs:

• “Viewing POS statistics,” next

• “Viewing PPP Link statistics” on page 65

• “Viewing PPP Link Quality Reporting statistics” on page 66

Field Description

Result Result of the test.

Code Code used for test.

PassCount Number of events which passed the test.

FailCount Number of events which failed the test.

Note: To run the external loopback test, you need a loopback cable on 
that port.
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• “Viewing Section statistics” on page 68

• “Viewing Line statistics” on page 69

• “Viewing FE Line statistics” on page 70

• “Viewing Path statistics” on page 71

• “Viewing FE Path statistics” on page 72

Refer to Reference for the 8000 Series Management Software Switching 
Operations, Release 3.1 for complete details on graphing statistics.

The values for the POS, PPP Link, and PPP LQR tabs are displayed for absolute, 
cumulative, average, minimum, maximum, and last values. 

The values for the POS, PPP Link, and PPP LQR tabs are updated based on the 
poll interval. 

For information on how to set the poll interval, refer to System and Platform 
Management.

Table 17 describes these values.

Table 17   Types of statistics

Field Description

AbsoluteValue The total count since the last reset of counters. A system reboot resets 
all counters. 

Cumulative The total count since the statistics tab was first opened. The elapsed 
time for the cumulative counter is displayed at the bottom of the 
statistics window. 

Average The cumulative count divided by the cumulative elapsed time.

Minimum The minimum average for the counter for a given polling interval over 
the cumulative elapsed time.

Maximum The maximum average for the counter for a given polling interval over 
the cumulative elapsed time.

LastValue The average for the counter over the last polling period.
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Viewing POS statistics

To display statistics POS statistics:

1 On the device view, right-click the port.

2 Choose Graph POS.

The graphSonetPort dialog box opens with the POS tab displayed (Figure 16). 

Figure 16   graphSonetPort dialog box — POS tab

Table 18 describes the fields in the POS tab.

Table 18   POS tab fields  

Field Description

InErrors Number of inbound packets that contained errors preventing 
them from being deliverable to a higher-layer protocol.

InUnknownProtos Number of packets received via the interface which were 
discarded because of an unknown or unsupported protocol.

OutErrors Number of outbound packets that contained errors preventing 
them from being deliverable to a higher-layer protocol.

HCInOctets The total number of octets received on the interface, including 
framing characters.
209564-B



Chapter 3 Configuring the 8683POSM Module Using Device Manager 65

 

Viewing PPP Link statistics

To display PPP Link statistics:

1 On the device view, right-click the port.

2 Choose Graph Port.

The graphSonetPort dialog box opens with the POS statistics tab displayed 
(Figure 16).

3 Click the PPP Link tab.

The PPP Link tab opens (Figure 17).

Figure 17   graphSonetPort dialog box — PPP Link tab

HCInUcastPkts Number of packets delivered by this sub-layer to a higher 
(sub-)layer, which were not addressed to a multicast or 
broadcast address at this sub-layer. 

HCInDiscards Number of inbound packets which were chosen to be 
discarded even though no errors had been detected to 
prevent their being deliverable to a higher-layer protocol.

HCOutOctets The total number of octets transmitted out of the interface, 
including framing characters.

HCOutUcastPkts Number of packets that higher-level protocols requested be 
transmitted, and which were not addressed to a multicast or 
broadcast address at this sub-layer, including those that were 
discarded or not sent. 

HCOutDiscards Number of outbound packets which were chosen to be 
discarded.

Table 18   POS tab fields (continued) 

Field Description
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Table 19 describes the fields in the PPP Link tab.

Viewing PPP Link Quality Reporting statistics

To display PPP Link Quality Reporting (LQR) statistics:

1 On the device view, right-click the port.

Table 19   PPP Link tab fields

Field Description

BadAddresses Number of packets received with an Incorrect Address Field. 
This counter is a Component of the ifInErrors variable that is 
associated with the interface that represents this PPP Link. 

BadControls Number of packets received on this link with an incorrect Control 
Field. This counter is a component of the ifInErrors variable that 
is associated with the interface that represents this PPP Link.

BadFCSs The number of received packets that have been discarded due 
to having an incorrect FCS.

LocalMRU This is the current value of the MRU (Maximum Receive Unit) 
that the remote entity is using when sending packets to the local 
PPP entity.

PacketTooLongs Number of received packets that have been discarded because 
their length exceeded the MRU. This counter is a component of 
the ifInErrors variable that is associated with the interface that 
represents this PPP Link. NOTE: packets which are longer than 
the MRU but which are successfully received and processed are 
NOT included in this count. 
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2 Choose Graph Port.

The graphSonetPort dialog box opens with the POS statistics tab displayed 
(Figure 16).

3 Click the PPP LQR tab.

The PPP LQR tab opens (Figure 18).

Figure 18   graphSonetPort dialog box — PPP LQR tab

Table 20 describes the fields in the PPP LQR tab.

Table 20   PPP LQR tab fields

Field Description

Quality This is the current quality of the link. It reflects the quality 
measurements with respect to the quality threshold.

InGoodOctets Number of good octets received on the interface.

LocalPeriod Time interval in 100th of a second between link quality reporting 
from local end.

RemotePeriod Time interval in 100th of a second between link quality reporting 
from remote end.

OutLQRs The number of Link Quality Reports transmitted by this node.

InLQRs The number of Link Quality Reports received by this node.
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Viewing Section statistics

To display Section statistics:

1 On the device view, right-click the port.

2 Choose Graph Port.

The graphSonetPort dialog box opens with the POS statistics tab displayed 
(Figure 16 on page 64).

3 Click the Section tab.

The Section tab opens (Figure 19).

Figure 19   graphSonetPort dialog box — Section tab 
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Table 21 describes the fields in the Section tab.

Viewing Line statistics

To display Line statistics:

1 On the device view, right-click the port.

2 Choose Graph Port.

The graphSonetPort dialog box opens with the POS statistics tab displayed 
(Figure 16 on page 64).

3 Click the Line tab.

The Line tab opens (Figure 20).

Table 21   Section tab fields

Field Description

ESs Errored Second (ES) is a second with one or more Coding Violations 
or one or more incoming defects, for example, SEF, LOS, AIS, LOP.

SESs Severely Errored Second (SES) is a second with x or more CVs, or a 
second during which at least one or more incoming defects.

SEFSs Severely Errored Framing Second (SEFS) is a second containing one 
or more SEF events.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP) errors that are 
detected in the incoming signal. CV counters are incremented for 
each BIP error detected.
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Figure 20   graphSonetPort dialog box — Line tab 

Table 22 describes the fields in the Line tab.

Table 22   Line tab fields

Viewing FE Line statistics

To display FE Line statistics:

1 On the device view, right-click the port.

2 Choose Graph Port.

The graphSonetPort dialog box opens with the POS statistics tab displayed 
(Figure 16 on page 64).

3 Click the FE Line tab.

The FE Line tab opens (Figure 21).

Field Description

ESs Errored Second (ES) is a second with one or more Coding Violations 
or one or more incoming defects, for example, SEF, LOS, AIS, or LOP.

SESs Severely Errored Second (SES) is a second with x or more CVs, or a 
second during which at least one or more incoming defects.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP) errors that are 
detected in the incoming signal. CV counters are incremented for 
each BIP error detected.

UASs Number of seconds that the interface is unavailable.
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Figure 21   graphSonetPort dialog box — FE Line tab

Table 23 describes the fields in the FE Line tab.

Table 23   FE Line tab fields

Viewing Path statistics

To display Path statistics:

1 On the device view, right-click the port.

2 Choose Graph Port.

The graphSonetPort dialog box opens with the POS statistics tab displayed 
(Figure 16 on page 64).

3 Click the Path tab.

The Path tab opens (Figure 22).

Field Description

ESs Errored Second (ES) is a second with one or more Coding Violations 
or one or more incoming defects, for example, SEF, LOS, AIS, or LOP.

SESs Severely Errored Second (SES) is a second with x or more CVs, or a 
second during which at least one or more incoming defects.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP) errors that are 
detected in the incoming signal. CV counters are incremented for 
each BIP error detected.

UASs Number of seconds that the interface is unavailable.
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Figure 22   graphSonetPort dialog box — Path tab

Table 24 describes the fields in the Path tab.

Table 24   Path tab fields 

Viewing FE Path statistics

To display Path statistics:

1 On the device view, right-click the port.

2 Choose Graph Port.

The graphSonetPort dialog box opens with the POS statistics tab displayed 
(Figure 16 on page 64).

3 Click the FE Path tab.

The FE Path tab opens (Figure 23).

Field Description

ESs Errored Second (ES) is a second with one or more Coding Violations 
or one or more incoming defects, for example, SEF, LOS, AIS, or LOP.

SESs Severely Errored Second (SES) is a second with x or more CVs, or a 
second during which at least one or more incoming defects.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP) errors that are 
detected in the incoming signal. CV counters are incremented for 
each BIP error detected.

UASs Number of seconds that the interface is unavailable.
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Figure 23   graphSonetPort dialog box — FE Path tab

Table 25 describes the fields in the FE Path tab.

Table 25   FE Path tab fields

Field Description

ESs Errored Second (ES) is a second with one or more Coding Violations 
or one or more incoming defects, for example, SEF, LOS, AIS, or LOP.

SESs Severely Errored Second (SES) is a second with x or more CVs, or a 
second during which at least one or more incoming defects.

CVs Coding Violations (CV) are Bit Interleaved Parity (BIP) errors that are 
detected in the incoming signal. CV counters are incremented for 
each BIP error detected.

UASs Number of seconds that the interface is unavailable.
Using the 8683POSM Module



74 Chapter 3 Configuring the 8683POSM Module Using Device Manager

 

209564-B



75

 

Chapter 4
Using the CLI 

Two management tools enable you to manage the 8683POSM Module: Device 
Manager and command line interface (CLI). You can also use the embedded 
web-based management feature to monitor the 8683POSM Module. See 
Chapter 5, “Web management,” on page 115 for information on using the 
web-based management feature.

This chapter describes how to use the CLI to configure POS-specific features, and 
contains the following topics: 

Configuring and managing POS

You can configure the 8683POSM Module in two basic modes: 

• Bridging: Bridging mode is enabled by default. Bridging is configured for 
connections between two 8683POSM Modules and between 8683POSM 
Modules and other devices that support PPP bridging.

• Routing: You select routing mode for connections between your 8683POSM 
Module and other POS-capable routers for IP and IPX routing.

This section describes how to use Device Manager to configure and manage POS, 
and includes the following topics:

Topic Page

Configuring and managing POS 75

Using the show commands 85

Using the monitor commands 111

Using the test commands 112
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• “Default 8683POSM configuration” on page 76”

• “Using the config poscard commands” on page 76”

• “Using the config pos port commands” on page 77”

• “Using the config pos info command” on page 81”

• “Using the config pos sonet command” on page 82

• “Using the config pos stg command” on page 83

• “Configuring routing” on page 83”

Default 8683POSM configuration

Table 3 on page 38 describes the default 8683POSM module configuration. 

Using the config poscard commands

The config poscard command allows you to:

• Reset the module

• Enable trace messages

• Display the image filename for the 8683POSM Module

The syntax is: 

config poscard <posslot number>

where <posslot number> is the slot number of the module in the 8600 chassis. 

Table 26 describes the parameters and variables for the config poscard 
command.
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Table 26   config poscard command parameters and variables

Using the config pos port commands

The port commands allow you to perform general configuration on the 
8683POSM Module. The syntax for the port config commands is:

• config pos <ports> 

• config pos <ports> ip 

• config pos <ports> ppp

• config pos <ports> sonet

• config pos <ports> stg

• config pos <ports> info

The port commands, variables and parameters and sub-commands are described 
in the following sections.

config pos command

Table 27 describes the parameters and variables for the config pos <ports> 
command.

Parameters and variables Description

card-reset Resets the card.

debug <enable | disable> Enables or disables trace messages on the module to 
be displayed on the console of the switch. 

info Displays the image filename and debug mode for the 
module.

pos-console <enable | disable> Prints the trace message POSM card. This is a priv 
command. When the pos-console is enabled (on the 
host), POS prints trace messages on the POS console. 
You can also use this command to query information on 
the POSM card or port. To use this command, you must 
be in priv mode. The syntax to enter priv mode is: 
config/poscard/<port number>/priv
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Table 27   config pos command parameters and variables

config pos ip

Use the config pos ip command to configure IP parameters on the 
8683POSM Module. 

Table 28 describes the parameters and variables for the config pos ip 
command.

Parameters and variables Description

default-vlan-id <vid> Directs the switch to send the untagged frames to a default VLAN if 
received on a tagged port. <vid> is the VLAN ID of the default VLAN 
to which the discarded frames are sent.

info Shows the last saved port settings and the next-level CLI commands. 
Note that this does not show the current settings, but the last saved 
settings. 

linktrap <enable | disable> Enables or disables the link up or down trap for a port.

lock <true | false> Locks a port for exclusive use if the port lock feature is globally 
enabled with the command config sys set portlock on 

name <name> Assign or set a name.

perform-tagging <enable | 
disable>

Enables or disables the IEEE 802.1Q tagging on the port.

state <enable | disable | test> Sets the state to enable, disable, or test.

tagged-frames-discard 
<enable | disable>

Sets a port with tagging disabled to discard tagging frames. 

untagged-frames-discard 
<enable | disable>

Sets a port with tagging enabled to discard untagged frames.

Note: When the 8600 switch is interoperating with a Juniper router, the 
POS port must have the Juniper IP address configured in the remote IP 
field. This is necessary because the Juniper routers do not provide their 
local IP address during PPP negotiation. The 8600 switch requires the 
Juniper address for IPCP operations. 

Note also that for the IP address assigned to the POS port, 30-bit subnet 
masks may be required for certain JUNOS releases.
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Table 28   config pos ip command  parameters and variables

config pos ppp

Use the config pos ppp command to configure Point-to-Point Protocol (PPP) 
parameters on the 8683POSM Module. 

Table 29 describes the parameters and variables for the config pos ppp 
command.

Table 29   config pos ppp command parameters and variables 

Parameters and variables Description

create <ipaddr/mask> <vid> 
[mac_offset <value>]

Creates an IP address and assigns it to a VLAN, with the VLAN ID.

delete <ipaddr> Deletes the IP address.

info Shows the last saved port settings and the next-level CLI commands. 
Note that this does not show the current settings, but the last saved 
settings. 

Parameters and variables Description

bridge-admin-status <open | 
close>

Enables or disables the bridge control protocol.

fcs-size<32 | 16> Sets the length of the redundancy check (fcs) to either 32 or 16.

info Shows the last saved port settings and the next-level CLI commands. 
Note that this does not show the current settings, but the last saved 
settings. 

ip-admin-status <open | close> Enables or disables the IP control protocol.

ipx-admin-status <open | close> Enables or disables the IPX control protocol.

ipx-route-protocol <none | rip> Sets the protocol for IPX routing.

lqr-period <interval> Sets the link quality reporting interval. Enter time in ms.

lqr-status <enable | disable> Enables or disables link quality reporting.

lqr-threshold <threshold> Sets the link quality reporting threshold. Enter %.

magic-number <true | false> Sets a random number (“magic number”) used in loopback detection. 
True detects loopback; false does not detect loopback.
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ppp-stpmode <enable | disable> Encapsulates spanning tree BPDU packets as PPP. When enabled 
the BPDUs are encapsulated as in RFC 1638. When disabled, the 
BPDUs travel as bridged data (assuming bridge-admin-status is 
enabled). 

remote-ip<ipaddr> Sets the remote iP address.
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Using the config pos info command

The config pos info command shows the current state of the port. 
Figure 24 shows a sample of the output from the config pos info command.

Figure 24   config pos info command sample output 

8610:5/config# pos 10/5 info
Port 10/5 :
                        lock : false
                        name :
         unknown-mac-discard : disable
             default-vlan-id : 1
             perform-tagging : disable
       tagged-frames-discard : disable
     untagged-frames-discard : disable
                       state : up
                    linktrap : enable
                   port-type : OC3-MMF

8610:5/config#
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Using the config pos sonet command

Use the config pos sonet command to configure SONET parameters on the 
8683POSM Module. 

Table 30 describes the parameters and variables for the config pos sonet 
command.

Table 30   config pos sonet command parameters and variables

Parameters and variables Description

clock-source <internal | line> Sets the clock source to:

• <internal>, which means clocking is derived from on-board 
clock.

• <line>, which means clocking is derived from line.

Note that if you have two connected modules, you must set both to 
internal or one to line and one to internal; do not set both to line.

framing <sonet | sdh> Sets the framing to:

• <sonet>, which means the Synchronous Optical Network 
format, the standard format used in North America.

• <sdh>, which means the Synchronous Digital Hierarchy clock 
format, the standard format used in Europe.

info Shows the last saved port settings and the next-level CLI commands. 
Note that this does not show the current settings, but the last saved 
settings. 

signal label Operational value of Path Signal Label (C2). The signal label value is 
reset when the scramble value is changed.

scramble <enable | disable> Enables or disables scrambling.

section-trace <sectiontrace> Sets the integer that the section trace flag (j0) is set to (1...255).

z0-increment Enables or disables z0 when the framing mode is set to SONET. This 
is a priv command - to use this command, you must be in privilege 
mode.The syntax to enter priv mode is: config/pos/<port 
number>/sonet priv
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Using the config pos stg command

Use the config pos stg command to configure STG parameters on the 
8683POSM Module. 

Table 31 describes the parameters and variables for the config pos stg 
command.

Table 31   config pos stg command parameters and variables 

Configuring routing 

A POS port configured for IPCP and/or IPXCP encapsulation must be the sole 
member of the VLAN. You cannot add any other port to a VLAN which already 
has a POS port with IPCP and/or IPXCP encapsulation enabled. You cannot add a 
POS port which is configured for IPCP and/or IPXCP encapsulation to a VLAN 
which already has other ports as members.

Parameters and variables Description

faststart <enable | disable> Enables or disables the fast start flag.

info Shows the last saved port settings and the next-level CLI commands. 
Note that this does not show the current settings, but the last saved 
settings. 

pathcost <intval> Sets the contribution of this port to the path cost.

priority <intval> Sets the priority of this port.

stg <enable | disable> Enables or disables spanning tree protocol.

Note: When the 8600 switch is interoperating with a Juniper router, the 
POS port must have the Juniper IP address configured in the remote IP 
field. This is necessary because the Juniper routers do not provide their 
local IP address during PPP negotiation. The 8600 switch requires the 
Juniper address for IPCP operations. 

Note also that for the IP address assigned to the POS port, 30-bit subnet 
masks may be required for certain JUNOS releases.
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Configuring IP routing

To configure the 8683POSM Modules for IP routing using the CLI:

1 To disable the selected port on the 8683POSM Module, enter: 

config pos <ports> state disable

2 To disable bridging, enter:

config pos <ports> bridge-admin-status close 

3 To configure IP routing, enter:

config pos <ports>> ppp ip-admin-status open

4 To configure an IP address on the selected port on the 8683POSM Module, 
enter:

config pos <ports> ip create <ipaddr/mask> <vid>

5 To enable the selected port on the 8683POSM Module, enter:

config pos <ports> state enable

Configuring IPX routing

To configure the 8683POSM Modules for IPX routing using the CLI:

1 Configure a protocol-based VLAN and assign the port to the VLAN as a static 
member and ensure that no other ports are allowed to join.

2 To disable the selected port on the 8683POSM Module, enter:

config pos <ports> state disable

3 To disable bridging, enter:

config pos <ports> bridge-admin-status close. 

4 To configure IPX routing, enter:

config pos <ports> ppp ipx-admin-status open.
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5 To enable the selected port on the 8683POSM Module, enter:

config pos <ports> state enable

Using the show commands

This section describes the show commands available with the 8683POSM 
Module. These commands allow you to view information about the module:

show ports info pos [<ports>]
show ports stats pos activealarms [<ports>]
show ports stats pos felinecurrent [<ports>]
show ports stats pos felineinterval <intervalid> [<ports>]
show ports stats pos fepathcurrent [<ports>]
show ports stats pos fepathinterval <intervalid> [<ports>]
show ports stats pos linecurrent [<ports>]
show ports stats pos lineinterval <intervalid> [<ports>]
show ports stats pos linkstatus [<ports>]
show ports stats pos lqrstatus [<ports>]
show ports stats pos pathcurrent [<ports>]
show ports stats pos pathinterval <intervalid> [<ports>>]
show ports stats pos pppiftbl [<ports>]
show ports stats pos sectioncurrent [<ports>]
show ports stats pos sectioninterval <intervalid> [<ports>]
show ports stats pos sonetmediumtbl [<ports>]

For a complete list of CLI commands, see the documentation associated with your 
software release on the Web at http://www.nortelnetworks.com/documentation.

show ports info pos

The show ports info pos command displays information (Figure 25) 
about the configuration for a specified port on the 8683POSM Module. 

The command uses the syntax: show ports info pos [<ports>] and options: 
all, ppp, sonet in the following syntax:

show ports info pos all
show ports info pos ppp
show ports info pos sonet
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show ports info pos all

Figure 25 shows sample output for the show ports info pos all 
command, which includes information for the PPP and SONET parameters.
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Figure 25   show ports info pos all command output

8610:5/show/ports/info/pos# all
========================================================================

SONET Config Info
========================================================================
PORT  FRAMING   CLOCK       SECTION   SIGNAL
NUM   MODE      SOURCE      TRACE     LABEL  SCRAMBLE
------------------------------------------------------------------------
10/1   sonet     line 1        0x16 enable
10/3   sonet     internal 1 0x16  enable
=========================================================================

SONET Local Operational Info
=========================================================================
PORT  FRAMING   CLOCK       SECTION   SIGNAL
NUM   MODE      SOURCE      TRACE     LABEL  SCRAMBLE
-------------------------------------------------------------------------
10/1   sonet     line        1         0x16   enable
10/3   sonet     internal  1         0x16   enable
=======================================================================

PPP Config Info
=======================================================================
PORT  ADMIN      BRIDGE     IP         IPX        MAGIC PPP
NUM   STATUS     ADMIN      ADMIN      ADMIN      NUMBERSTPMODE LQSTATUS
------------------------------------------------------------------------
10/1   up         open       close      close      false enable enable
10/3   up         open       close      close      false enable enable

PORT                 FCS  IPX ROUTE  LQR-QUAL   LQR-QUAL
NUM   SPEED   MRU    SIZE PROTOCOL   THRESHOLD  PERIOD REMOTE IP 
-------------------------------------------------------------------
10/1   OC3-MMF 1936 32   rip  95         100       0.0.0.0 -M
10/3   OC3-MMF 1936 32   rip  95         100       0.0.0.0 -M

PORT IPX NET
NUM  ADDR
-------------------------------------------------------------------
10/1 0000000
10/3 0000000
================================================================================
                                        PPP Local Operational Info
================================================================================
PORT  STATUS        LCP        BRIDGE     IP         IPX        MAGIC
NUM   OPERATE    STATUS     STATUS     STATUS     STATUS     NUMBER     STPMODE
-------------------------------------------------------------------------
10/1   up         up         down       up         down       false enable
10/3   up         up         down       up         down       false enable
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Figure 26   show ports info pos all command output (continued) 

Table 32 describes the fields for output of the show ports info pos all 
command

PORT  PPP               FCS  IPX ROUTE  LQR-QUAL   LQR-QUAL
NUM   LQSTATUS   MRU    SIZE PROTOCOL   THRESHOLD  PERIOD    REMOTE IP
-----------------------------------------------------------------------------
10/1  enable     1936   32   none       95         100       10.32.6.14
10/3   enable     1936   32   none       95         100       10.32.6.10

PORT  IPX NET
NUM   ADDR
----------------------------------------------------------------------------
10/1   00000000
10/3   00000000
=====================================================================
                                        Other Info
=====================================================================
PORT  POS S/W  PLD     FRAMER  CARD
NUM   VERSION  VERSION VERSION VERSION
---------------------------------------------------------------------
10/1   51       7       2       POS  7 

8610:5/show/ports/info/pos# all
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.

Table 32   show ports info pos all command parameters

Field Description

PORT NUM Port number.

FRAMING MODE Indicates whether the framing mode is either:

• sonet

• sdh

CLOCK SOURCE Indicates whether the clock source is either:

• line

• internal

SECTION TRACE Indicates the integer that the section trace flag (j0) is set to.

SIGNAL LABEL Operational value of Path Signal Label (C2). The signal 
label value is reset when the scramble value is changed.

SCRAMBLE Enables or disables the scrambling option.

ADMIN STATUS Sets the port to one of the following states:

• up

• down

• testing

BRIDGE ADMIN This parameter indicates bridged traffic within PPP.

IP ADMIN This parameter indicates the IP traffic (link) within PPP.

IPX ADMIN This parameter indicates the IPX traffic (link) within PPP.

MAGIC NUMBER If set to enable, selects a random number (“magic 
number”) used in loopback detection. enable detects 
loopback; disable does not detect loopback.

STPMODE Spanning Tree Protocol mode - This parameter enables 
BPDUs to be received or transmitted with BPDU specific 
encapsulation. When disabled, encapsulated within 
Ethernet frames.

PPP LQSTATUS Sets the link quality reporting interval.

SPEED Displays the current operating speed of the port. It can be 
either 155 or 622 Mb/s depending on the type of interface 
installed.

MRU Size (in octets) of the largest packet that can be sent or 
received on the interface. For IPCP and IPXCP, the 
maximum is 1936. When BCP is enabled, however, the 
maximum is 1934. Check which NCP is enabled before 
configuring the Mru.

Note: The Bridge Control Protocol (BCP) is enabled on the 
8683POSM Module by default. 
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show ports stats pos activealarms 

This command displays active alarms on the 8683POSM Module port. The 
command uses the syntax: 

show ports stats pos activealarms [<ports>]

Figure 27 shows output for the show ports stats pos activealarms 
command.

FCS SIZE Sets the length of the redundancy check (fcs) to either 32 
or 16.

IPX ROUTE PROTOCOL Sets the protocol for IPX routing.

LQR-QUAL THRESHOLD Indicates the link quality reporting threshold.

LQR-QUAL PERIOD Indicates the link quality reporting interval.

REMOTE IP Indicates the remote iP address.

IPX NET ADDR Indicates the IPX net address.

STATUS OPERATE Operational status.

LCP STATUS Link Control Protocol status.

BRIDGE STATUS Bridging status.

IP STATUS Routing (IP) status.

IPX STATUS Routing (IPX) status

PPP LQSTATUS Point-to-Point status

Table 32   show ports info pos all command parameters (continued)

Field Description
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Figure 27   show ports stats pos activealarms command output

Table 33 describes the information fields for output for the show ports 
stats pos activealarms command.

Table 34 lists the alarms that are specific to the 8683POSM Module. The alarms 
are listed in order of priority.

Table 33   show ports stats pos activealarms command parameters

Field Description

PORT NUM Port number.

ACTIVE ALARM Displays active alarms on the port. 

Table 34   8683POSM Module alarms

Name Description

Section alarms

LOS Loss of signal - not enough Rx power or fiber disconnected.

LOF Loss of frame - unable to frame the signal correctly, possibly due 
to improper timing setup.

Line Alarms

L-AIS Alarm Indication Signal - sent out when a port is disabled or 
indicates another line failure.

L-RDI Remote Defect Indication - the result of a L-AIS or LOS/LOF at 
the remote end.

8610:5/show/ports# stats pos activealarms
=======================================================

Active Alarms
=======================================================
PORT
NUM     ACTIVE ALARM
---------------------------------------------------------
10/5     No Defect
10/6     LOS

8610:5/show/ports/stats/pos#
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show ports stats pos felinecurrent

This command displays current statistics on the far end line, which is at the 
receiving end. The command uses the syntax: 

show ports stats pos felinecurrent [<ports>]

Figure 28 shows sample output for the show ports stats pos 
felinecurrent command. 

Figure 28   show ports stats pos felinecurrent command output

Path Alarms

P-AIS Path Alarm Indication Signal - indicates a propagation upstream 
of a downstream L-AIS alarm or another path failure.

P-LOP Path Loss of Pointer - the pointer to the Sonet SPE is not correct; 
sometimes due to dirty fiber, or timing slips.

P-RDI Path Remote Indicator - the result of a P-AIS alarm at the remote 
end.

P-SLM Path Signal Label Mismatch - path labels do not match, in 
particular the C2 label is mismatched. (The C2 label is used to 
indicate scrambling according to RFC 2615.)

P-UNEQ Unequipped Path Alarm - the path does not have a valid sender.

Table 34   8683POSM Module alarms (continued)

Name Description

8610:5/show/ports/stats/pos# felinecurrent
======================================================================

POS Far End Line Current Stats
======================================================================
PORT     ERRORED SECONDS   SEVERELY ERRORED   CODE VIOLATION UNAVAILABLE
NUM      COUNT (ES)        COUNT (SES)        COUNT (CV-L) SECONDS(UAS)
----------------------------------------------------------------------
10/5  0                 0                  0                 0
10/6  0                 0                  0                 0

8610:5/show/ports/stats/pos#
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Table 35 describes the show ports stats pos felinecurrent command 
parameters. 

show ports stats pos felineinterval 

This command displays statistics (Figure 29) on the far end line over a 15-minute 
interval. You specify which interval, or span of intervals, to display for the 
command. The command uses the syntax: 

show ports stats pos felineinterval <intervalid> [<ports> ]

Table 35   show ports stats pos felinecurrent command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-L)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal. CV 
counters are incremented for each BIP error detected.

UNAVAILABLE SECONDS Number of seconds that the interface is unavailable.
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Figure 29   show ports stats pos felineinterval command output 

Table 36 describes the show ports stats pos felineinterval command

8610:5/show/ports/stats/pos# felineinterval 4
======================================================================

POS Far End Line Interval Stats
======================================================================
PORT     ERRORED SECONDS   SEVERELY ERRORED   CODE VIOLATION UNAVAILABLE
NUM      COUNT (ES)        COUNT (SES)        COUNT (CV-L) SECONDS(UAS)
----------------------------------------------------------------------
10/5  0                 0                  0                 0
10/6  0                 0                  0                 0

INTERVAL ID = 4
8610:5/show/ports/stats/pos#
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show ports stats pos fepathcurrent 

This command displays current statistics (Figure 30) for the far end path, which is 
at the receiving end. The command uses the syntax: 

show ports stats pos fepathcurrent [<ports>]

Figure 30   show ports stats pos fepathcurrent command output 

Table 36   show ports stats pos felineinterval command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-L)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal. CV 
counters are incremented for each BIP error detected.

UNAVAILABLE SECONDS 
(UAS)

Number of seconds that the interface is unavailable.

INTERVAL ID Specified interval.

8610:5/show/ports/stats/pos# fepathcurrent
=========================================================================

POS Far End Path Current Stats
=========================================================================
PORT     ERRORED SECONDS   SEVERELY ERRORED   CODE VIOLATION    UNAVAILABLE
NUM      COUNT (ES)        COUNT (SES)        COUNT (CV-P)      SECONDS(UAS)
-------------------------------------------------------------------------
10/1      0                 0                  0                 0
10/3      0                 0                  0                 527

8610:5/show/ports/stats/pos#
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Table 37 describes the show ports stats pos fepathcurrent command 
parameters.

show ports stats pos fepathinterval 

This command displays statistics (Figure 31) on the far end path over a 15-minute 
interval. You specify the interval or span of intervals to display. The command 
uses the syntax: 

show ports stats pos fepathinterval <intervalid> [<ports>]

Table 37   show ports stats pos fepathcurrent command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-P)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal.  CV 
counters are incremented for each BIP error detected.

UNAVAILABLE SECONDS 
(UAS)

Number of seconds that the interface is unavailable.
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Figure 31   show ports stats pos fepathinterval command output 

Table 38 describes the show ports stats pos fepathinterval 
command parameters.

Table 38   show ports stats pos fepathinterval command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-P)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal.  CV 
counters are incremented for each BIP error detected.

UNAVAILABLE SECONDS 
(UAS)

Number of seconds that the interface is unavailable.

INTERVAL ID Specified interval.

8610:5/show/ports/stats/pos# fepathinterval 1

=========================================================================
POS Far End Path Interval Stats

=========================================================================
PORT     ERRORED SECONDS   SEVERELY ERRORED   CODE VIOLATION    UNAVAILABLE
NUM      COUNT (ES)        COUNT (SES)        COUNT (CV-P)      SECONDS(UAS)
------------------------------------------------------------------------
10/1      0                 0                  0 0
10/3      0                 0                  0                 900

INTERVAL ID = 1

8610:5/show/ports/stats/pos#
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show ports stats pos linecurrent

This command displays current statistics (Figure 32) for the line. The command 
uses the syntax: 

show ports stats pos linecurrent [<ports>]

Figure 32   show ports stats pos linecurrent command output 

Table 39 describes the show ports stats pos linecurrent command 
parameters.

8610:5/show/ports/stats/pos# linecurrent

=========================================================================
POS Line Current Stats

========================================================================
PORT  ERRORED SECONDS  SEVERELY ERRORED  CODE VIOLATION  UNAVAILABLE
NUM   COUNT (ES)       COUNT (SES)       COUNT (CV-L)    SECONDS (UAS) STATUS
-------------------------------------------------------------------------
10/1   0                0                 0               277 No Defect
10/3   0                0                 0               787  Line AIS

8610:5/show/ports/stats/pos#
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show ports stats pos lineinterval 

This command displays statistics (Figure 33) for the line over a 15-minute 
interval. You can specify any interval or span of intervals. The command uses the 
syntax: 

show ports stats pos lineinterval <intervalid> [<ports>]

Table 39   show ports stats pos linecurrent command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-P)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal.  CV 
counters are incremented for each BIP error detected.

UNAVAILABLE SECONDS 
(UAS)

Number of seconds that the interface is unavailable.

STATUS Status of defects.
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Figure 33   show ports stats pos lineinterval command output

Table 40 describes the show ports stats pos lineinterval command 
parameters 

show ports stats pos linkstatus 

This command displays current statistics (Figure 34) on the frames coming across 
the PPP link. The command uses the syntax: 

Table 40   show ports stats pos lineinterval command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-P)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal.  CV 
counters are incremented for each BIP error detected.

UNAVAILABLE SECONDS 
(UAS)

Number of seconds that the interface is unavailable.

STATUS Indicates status of defects.

8610:5/show/ports# stats pos lineinterval 1

============================================================================
                                        POS Line Interval Stats
============================================================================
PORT     ERRORED SECONDS   SEVERELY ERRORED   CODE VIOLATION    UNAVAILABLE
NUM      COUNT (ES)  COUNT (SES)  COUNT (CV-L) SECONDS (UAS)
----------------------------------------------------------------------------
3/5      0                 0                  0                 0
3/6      0                 0                  0                 0
INTERVAL ID = 1
8610:5/show/ports#
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show ports stats pos linkstatus [<ports>]

Figure 34   show ports stats pos linkstatus command output 

Table 41 describes the show ports stats pos linkstatus command 
parameters.

show ports stats pos lqrstatus

This command displays current statistics (Figure 35) on the link quality reporting. 
The command uses the syntax:

show ports stats pos lqrstatus [<ports>]

Table 41   show ports stats pos linkstatus command parameters

Field Description

PORT NUM Port number.

BAD ADDR FRAMES Number of packets received with an Incorrect Address Field. 
This counter is a Component of the ifInErrors variable that is 
associated with the interface that represents this PPP Link.

BAD CNTL FRAMES Number of packets received on this link with an incorrect 
address field. 

TOO LONG FRAMES Number of packets received and discarded because their 
length exceeded the MRU.

BAD FCS FRAMES Number of packets received with an incorrect FCS size.

MRU Maximum Receive Unit

8610:5/show/ports/stats/pos# linkstatus

=========================================================================
POS Link Stats

=========================================================================
PORT   BAD ADDR   BAD CNTL   TOO LONG   BAD FCS
NUM    FRAMES     FRAMES     FRAMES     FRAMES     MRU
-------------------------------------------------------------------------
10/1    0          0          0          1936 1936
10/3    0          0          0          0          0

8610:5/show/ports/stats/pos#
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Figure 35   show ports stats pos lqrstatus command output 

Table 42 describes the show ports stats pos lqrstatus command 
parameters.

show ports stats pos pathcurrent 

This command displays current statistics (Figure 36) on the path, on the 
transmitting end. The command uses the syntax: 

show ports stats pos pathcurrent [<ports>]

Table 42   show ports stats pos lqrstatus command parameters

Field Description

PORT NUM Port number.

QUALITY This is the current quality of the link. It reflects the quality 
measurements with respect to the quality threshold.

IN GOOD OCTs Number of good octets received at the port.

LOCAL PERIOD Time interval in 100th of a second between link quality 
reporting from the local end.

REMOTE PERIOD Time interval in 100th of a second between link quality 
reporting from the remote end.

OUT LQRs The number of Link Quality Reports transmitted by this 
node.

INLQRs The number of Link Quality Reports received by this node.

8610:5/show/ports/stats/pos# lqrstatus

===========================================================================
POS Link Quality Stats

===========================================================================
PORT
NUM      QUALITY   IN GOOD OCTs   LOCAL PERIOD    REMOTE PERIOD OUTLQRs INLQRs
----------------------------------------------------------------------------
10/5       100 4793094  100 100 40665 40666
10/6       0 0  0 0 0        0

8610:5/show/ports/stats/pos#
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Figure 36   show ports stats pos pathcurrent command output 

Table 43 describes the show ports stats pos pathcurrent command 
parameters.

8610:5/show/ports/stats/pos# pathcurrent

=========================================================================
POS Path Current Stats

=========================================================================
PORT  ERRED SECS  SEVERELY ERRED CODE VIOLATION  UNAVAILABLE
NUM   COUNT (ES)  COUNT (SES)    COUNT (CV-P)    SECONDS (UAS)  STATUS WIDTH
-------------------------------------------------------------------------

10/5       0                 0                             0                                0                         No Defect    2
10/6       0                  0                              0                               302                       Path AIS  2
8610:5/show/ports/stats/pos#
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show ports stats pos pathinterval 

This command displays statistics (Figure 37) on the path for a 15-minute interval. 
You specify the interval or span of intervals to display. The command uses the 
syntax: 

show ports stats pos pathinterval <intervalid> [<ports>]

Figure 37   show ports stats pos pathinterval command output 

Table 43   show ports stats pos pathcurrent command parameters

Field Description

PORT NUM Port number.

ERRED SECS COUNT (ES) Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-P)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal.  CV 
counters are incremented for each BIP error detected.

UNAVAILABLE SECONDS 
(UAS)

Number of seconds that the interface is unavailable.

STATUSWIDTH Indicates status and number of defects.

8610:5/show/ports/stats/pos# pathinterval 4

=========================================================================
POS Path Interval Stats

=========================================================================
PORT     ERRORED SECONDS   SEVERELY ERRORED   CODE VIOLATION    UNAVAILABLE
NUM      COUNT (ES)        COUNT (SES)        COUNT (CV-P)      SECONDS(UAS)
-------------------------------------------------------------------------
10/1      0                 0                  0 0
10/3      0                 0                  0                 900

INTERVAL ID = 4
8610:5/show/ports/stats/pos#
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Table 44 describes the show ports stats pos pathinterval command.

show ports stats pos pppiftbl 

This command displays statistics (Figure 38) on the PPP link. The command uses 
the syntax:

show ports stats pos pppiftbl [<ports>]

Table 44   show ports stats pos pathinterval command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-P)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal.  CV 
counters are incremented for each BIP error detected.

UNAVAILABLE SECONDS 
(UAS)

Number of seconds that the interface is unavailable.

INTERVAL ID Specified interval.
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Figure 38   show ports stats pos pppiftbl command output 

Table 45 describes the show ports stats pos pppiftbl command 
parameters.

Table 45   show ports stats pos pppiftbl command parameters

Field Description

PORT NUM Port number.

OCTETS RECEIVED Number of octets received at the port.

PACKETS RECEIVED Number of packets received at the port.

DROPPED RX PACKETS Number of RX packets dropped at the port.

ERRORED RX PACKETS Number of RX packet errors at the port.

UNKNOWN PROTOCOLS Number of unknown protocols.

OCTETS TRANSMITTED Number of octets transmitted.

PACKETS TRANSMITTED Number of packets transmitted.

DROPPED TX PACKETS Number of TX packets dropped at the port.

ERRORED TX PACKETS Number of TX packet errors at the port.

8610:5/show/ports/stats/pos# pppiftbl

=========================================================================
PPP IF Table Contents

=========================================================================
PORT    OCTETS       PACKETS      DROPPED      ERRORED      UNKNOWN
NUM     RECEIVED     RECEIVED     RX PACKETS   RX PACKETS   PROTOCOLS
-------------------------------------------------------------------------
10/1 4637499 65449  0 0 0
10/3 0 0  0 0 0

PORT    OCTETS       PACKETS      DROPPED      ERRORED
NUM     TRANSMITTED  TRANSMITTED  TX PACKETS   TX PACKETS
------------------------------------------------------------------------
10/1    2769051532 4610831 0 0
10/3    20 1 0 0

8610:5/show/ports/stats/pos#
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show ports stats pos sectioncurrent 

This command displays the current statistics (Figure 39) on the section. The 
command uses the syntax: 

show ports stats pos sectioncurrent [<ports>]

Figure 39   show ports stats pos sectioncurrent command output 

Table 46 describes the show ports stats pos sectioncurrent 
command parameters.

8610:5/show/ports/stats/pos# sectioncurrent

==========================================================================
POS Section Current Stats

==========================================================================
PORT  ERRORED SECONDS SEVERELY ERRORED CODE VIOLATION  SEVERELY ERRORED
NUM   COUNT (ES)      COUNT (SES)      COUNT (CV-S)    FRAMES (SEF) STATUS
--------------------------------------------------------------------------
10/1        0 0 0 0 No Defect
10/3 620 620     0 0 LOS

8610:5/show/ports/stats/pos#
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show ports stats pos sectioninterval 

This command displays statistics (Figure 40) on the section over a 15-minute 
interval. You specify the interval or span of intervals to display. The command 
uses the syntax: 

show ports stats pos sectioninterval <intervalid> [<ports>]

Table 46   show ports stats pos sectioncurrent command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-S)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal.  CV 
counters are incremented for each BIP error detected.

SEVERELY ERRORED 
FRAMES (SEF)

Number of seconds that the interface is unavailable.

STATUS Indicates status of defects.
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Figure 40   show ports stats pos sectioninterval command output 

Table 47 describes the show ports stats pos sectioninterval 
command parameters.

Table 47   show ports stats pos sectioninterval command parameters

Field Description

PORT NUM Port number.

ERRORED SECONDS 
COUNT (ES)

Errored Second (ES) is a second with one or more Coding 
Violations (CV) or one or more incoming defects (for 
example, SEF, LOS, AIS, LOP).

SEVERELY ERRORED 
COUNT (SES)

Severely Errored Second (SES) is a second with x or more 
CVs, or one or more incoming defects.

CODE VIOLATION COUNT 
(CV-S)

Coding Violations (CV) are Bit Interleaved Parity (BIP) 
errors that are detected in the incoming signal.  CV 
counters are incremented for each BIP error detected.

SEVERELY ERRORED 
FRAMES (SEF)

Severely Errored Framing Second (SEFs) is a second 
containing one or more SEF events.

INTERVAL ID Specified interval.

8610:5/show/ports/stats/pos# sectioninterval 3

===========================================================================
POS Section Interval Stats

===========================================================================
PORT     ERRORED SECONDS   SEVERELY ERRORED   CODE VIOLATION SEVERELY ERRORED
NUM      COUNT (ES)        COUNT (SES)        COUNT (CV-S) FRAMES (SEF)
---------------------------------------------------------------------------
10/1 0 0 0 0
10/3 900 900 0 0

INTERVAL ID = 10
8610:5/show/ports/stats/pos#
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show ports stats pos sonetmediumtbl 

This command displays statistics (Figure 41) on the SONET medium. The 
command uses the syntax: 

show ports stats pos sonetmediumtbl [<ports>]

Figure 41   show ports stats pos sonetmediumtbl command output 

Table 48 describes the show ports stats pos sonetmediumtbl 
command parameters.

-8610:5/show/ports/stats/pos# sonetmediumtbl

=========================================================================
POS SONET Medium Table

=========================================================================
PORT     MEDIUM    TIME      VALID      LINE      LINE      CIRCUIT
NUM      TYPE      ELAPSED   INTERVALS  CODING    TYPE      ID
-------------------------------------------------------------------------
10/1 1  816         45  4  4         52689832
10/3 1  816         45  4  4         52689832
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Using the monitor commands 

This section describes the monitor commands available with the 8683POSM 
Module. The monitor commands are self-updating show commands, set from the 
CLI for duration and interval. These commands allow you to view constantly 
updating information about the module. The monitor commands use the following 
syntax:

monitor ports stats pos activealarms [<ports>]
monitor ports stats pos felinecurrent [<ports>]
monitor ports stats pos felineinterval <intervalid> 
[<ports>]
monitor ports stats pos fepathcurrent [<ports>]
monitor ports stats pos fepathinterval <intervalid> 
[<ports>]
monitor ports stats pos linecurrent [<ports>]
monitor ports stats pos lineinterval <intervalid> [<ports>]
monitor ports stats pos linkstatus [<ports>]

Table 48   show ports stats pos sonetmediumtbl command parameters

Field Description

PORT NUM Port number.

MEDIUM TYPE Identifies whether a sonet or sdh signal is used across the 
interface.

TIME ELAPSED Number of seconds, including partial seconds, that have 
elapsed since the beginning of the current measurement 
period. If the current interval exceeds the maximum value, 
the agent will return the maximum value.

VALID INTERVALS Number of previous 15-minute intervals for which data was 
collected.

LINE CODING Line coding for this interface. The B3ZS and CMI are used 
for electrical SONET/SDH signals (STS-1 and STS-3). The 
Non-Return to Zero (NZR) and the Return to Zero are used 
for optical SONET/SDH signals.

LINE TYPE Line type for this interface. The line types are Single Mode 
fiber or Multi-Mode fiber interfaces. 

CIRCUIT ID Transmission vendor's circuit identifier, to facilitate 
troubleshooting. 
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monitor ports stats pos lqrstatus [<ports>]
monitor ports stats pos pathcurrent [<ports>]
monitor ports stats pos pathinterval <intervalid> [<ports>]
monitor ports stats pos pppiftbl [<ports>]
monitor ports stats pos sectioncurrent [<ports>]
monitor ports stats pos sectioninterval <intervalid> 
[<ports>]
monitor ports stats pos sonetmediumtbl [<ports>]

Using the test commands

This section describes the test commands available with the 8683POSM Module. 
The test commands allow you test the module while the switch is operating. The 
tests do not interfere with the module’s normal switching functions, but they do 
occupy the CPU. The test commands allow you to test:

• Hardware 

• LEDS 

• Internal and external loopback

The syntax for the test commands is:

test hardware <ports>

test led <ports> <tx|rx> <off|yellow|green>

test loopback <ports> [<int|ext>] 

test hardware 

Use the test hardware command to run diagnostics on the 8683POSM 
Module. The command uses the following syntax: 

Note: You must specify a slot and port number with the test commands.
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test hardware <ports>

The output from the test hardware command is shown in Figure 42.

Figure 42   test hardware command output

test led 

Use the test led command to see if the lights on the port LEDs are functioning 
correctly on the 8683POSM Module. The command uses the following syntax: 

test led <ports> <tx|rx> <off|yellow|green>

Table 49 describes the parameters and variables for the test led command.

Note: You must physically inspect the LEDs on the actual 8683POSM 
Module to view the results of these tests.

Table 49   test led command parameters and variables

Parameters and variables Description

tx Tests the LED for transmitting data on each port.

rx Tests the LED for receiving data on each port.

off Tests whether the LEDs go off correctly.

yellow Tests whether the LEDs can light yellow.

green Tests whether the LEDs can light green.

8610:test hardware 10/5

Port: 10/5
  IfIndex: 645
   Result: success
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test loopback 

Use the test loopback command to run a loopback test on the port. You can 
perform either an internal or an external loopback test on the POSM module. The 
default is internal loopback. The syntax is:

test loopback <ports> <int|ext>

To test for loopback:

1 To configure the port for testing, enter:

config pos <ports> test

2 To test the loopback, either internal or external, enter:

test loopback <ports> <int|ext>

3 To stop the loopback testing, enter:

test stop loopback <ports>

Figure 43 shows output for the test loopback command.

Figure 43   test loopback command output 

Note: The loopback tests test only the control path; they do not test the 
data path.

8610:5/show/test# loopback 10/6

Running an internal loopback test...
Current test results:

     Port: 10/6
  IfIndex: 645
   Result: inProgress
PassCount: 0
FailCount: 0
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Chapter 5
Web management

The Web interface allows you to monitor the 8683POSM Module through a World 
Wide Web browser from anywhere on your network. The Web interface provides 
many of the same monitoring features as the Device Manager software. 

Refer to Getting Started with the 8000 Series Management Software for 
information on:

• Accessing your switch through the Web interface

• Descriptions of the Web page layout

Use the Web interface to monitor the 8683POSM Module parameters. When you 
access the Web interface, the System page is displayed. The POS folder is in the 
navigation pane on the left of the System page (Figure 44).
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Figure 44   System page

Table 50 describes the System page fields.
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When you click on POS in the navigation pane, the headings in the POS menu are 
displayed. The headings provide options for viewing POS parameters (Figure 45). 

Table 50   System page fields

Field Description

sysDescr System description.

sysUpTime Value of system up time.

sysContact Contact name.

sysName Port name.

sysLocation System location.

Authentication Traps Displays whether traps are enabled or disabled.

EnableWebServer Indicates whether the web server has been enabled.

EnableAccessPolicy Indicates whether access policy has been enabled.

LastChange Value of sysUpTime at the time the interface entered its 
current operational state.

LastVlanChange Value of sysUpTime at the time the VLAN entered its 
current operational state.

LastStatisticsReset Value of sysUpTime at the time that statistics were 
enabled.

LastRuntimeConfigSave Value of sysUpTime at the time that configuration was 
saved.

LastRuntimeConfigSavetoSlave Value of sysUpTime at the time that configuration was 
saved.

LastBootConfigSave Value of sysUpTime at the time the last reboot occurred. 

LastBootConfigSaveOnSlave Value of sysUpTime at the time the last reboot saved 
configuration changes.

DefautlRuntimeConfigFileName Default runtime configuration file name.

DefaultBootConfigFileName Default configuration file name.

ConfigFileName Configuration file name.
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Figure 45   System page showing the POS menu 

To view the current SONET parameters, in the POS menu, click Sonet. The Sonet 
page opens (Figure 46).
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Figure 46   SONET page

Table 51 describes the SONET page fields.

To view the current link parameters, in the POS menu, click Link. The Link page 
opens (Figure 47).

Table 51   SONET page fields

Field Description

Index Unique value assigned to each interface.

Framing Indicates if framing is enabled or disabled.

Section Trace Indicates the integer that the section trace is set to.

Signal Label Indicates operational value of Path Signal Label.

Clock Source Indicates setting of the clock source.

Scramble Indicates operational value of SONET scramble.
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Figure 47   Link page

Table 52 describes the Link page fields.

To view the current bridging parameters, in the POS menu, click Bridge. The 
Bridge page opens (Figure 48).

Table 52   Link page fields

Field Description

Index Unique value assigned to each interface.

Link Config Magic 
Number

If set to enable, selects a random number (“magic number”) 
used in loopback detection. 

Link Config Crc Size Indicates if the size of redundancy check field used in PPP 
framing has been configured.
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Figure 48   Bridge page

Table 53 describes the Bridge page fields.

To view the current IP parameters, in the POS menu, click IP. The IP page opens 
(Figure 49).

Table 53   Bridge page fields

Field Description

Index Unique value assigned to each interface.

Bcp Admin Status Indicates the status of bridging.

Oper Status Indicates the operational state of bridging.
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Figure 49   IP page

Table 54 describes the IP page fields.

To view the current IPX parameters, in the POS menu, click IPX. The IPX page 
opens (Figure 50).

Table 54   IP page

Field Description

Index Unique value assigned to each interface.

Ipcp Admin Status Indicates the status of IP routing, either enabled or 
disabled.

Oper Status Indicates the operational value of IP link.
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Figure 50   IPX page

Table 55 describes the fields displayed IPX page fields.

To view the current Lqr parameters, in the POS menu, click Lqr. The Lqr page 
opens (Figure 51).

Table 55   IPX page fields

Field Description

Index Unique value assigned to each interface.

Ipxcp Admin Status Indicates the status of IPX routing, either enabled or disabled.

Oper Status Indicates the operational value of IPX link.

Net Addr Network address.
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Figure 51   Lqr page

Table 56 describes the Lqr page fields.

To view the current Line parameters, in the POS menu, click Line. The Line page 
opens (Figure 52).

Table 56   Lqr page fields

Field Description

Index Unique value assigned to each interface.

Config Status Status of link quality reporting.

Config Interval Link quality reporting interval.
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Figure 52   Line page

Table 57 describes the Line page fields.

To view the current Sonet Medium parameters, in the POS menu, click Sonet 
Medium. The Sonet Medium page opens (Figure 53).

Table 57   Line page fields

Field Description

Index Unique value assigned to each interface.

Config PPP Stp Status of PPP bridging.

Local Ip Addr Local Internet Protocol address.

Remote IP Addr Remote Internet Protocol address.

Config Lqr Threshold Link quality reporting threshold.
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Figure 53   SONET Medium page

Table 58 describes the SONET Medium page fields.

Table 58   SONET Medium page fields

Field Description

Index Unique value assigned to each interface.

Type Signal type, whether sonet or sdh.

Time Elapsed Number of seconds that have elapsed since the beginning of 
the current measurement period.

Valid Intervals Number of previous 15-minute intervals for which data was 
collected. 

Line Coding Line coding for this interface: the B3ZS and CMI are used for 
electrical SONE/SDH signals (STS-1 and STS-3). The 
Non-Return to Zero (NZR) and the Return to Zero are used for 
optical SONET/SDH signals.

Line Type Line type: short and long range single-mode fiber or 
multimode fiber interfaces, and COAX and UTP for electrical 
interfaces. 

Circuit Identifier Transmission vendor’s circuit identifier, to facilitate 
troubleshooting.
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Statistics

Use the Web interface to view the 8683POSM Module statistics. Under the 
Statistics heading in the navigation pane, there are two options: Chassis and Port. 
Click Port to view the options. Sonet is the last entry in the Port folder.

The Sonet heading contains the options shown in Figure 54.

Figure 54   Sonet options 

Click any of the headings to view the relevant statistics. 

See Figure 55 for an example of PPP Link statistics.
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Figure 55   PPP Link statistics page
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Appendix A
Technical Specifications

This appendix lists the technical specifications for the 8683POSM Module.

Standards supported

Bell Communications Research, SONET Transport Systems: Common Generic 
Criteria, GR-253-CORE, January 1999, Revision 2 (partial compliance)

RFC 1213, Network Management of TCP/IP-based internets, March 1991

RFC 1332, PPP Internet Protocol Control Protocol (IPCP), May 1992

RFC 1471, Link Control Protocol of the PPP, June 1993

RFC 1473, IP Network Control Protocol of the PPP, June 1993

RFC 1474, Bridge Network Control Protocol of the PPP, June 1993

RFC 1552, PPP Internetwork packet Exchange Control Protocol (IPXCP), May 
1992

RFC 1661, The Point-to-Point Protocol (PPP), July 1994.

RFC 1638, PPP Bridging Control Protocol (BCP), June 1994

RFC 1989, PPP Link Quality Monitoring, August 1996

RFC 2558, SONET/SDH, March 1999

RFC 2615, PPP Over SONET/SDH (obsoletes RFC 1619), June 1999
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Environmental 
specifications

Operating temperature: 5° to 40° C (41° to 104° F)

Storage temperature:  -25° to 70° C (-13° to 158° F)

Operating humidity: 85% maximum relative humidity, noncondensing

Storage humidity: 95% maximum relative humidity, noncondensing

Operating altitude 3,000 m (10,000 feet) maximum

Storage altitude Up to 9,000 m (30,000 feet) above sea level

Free Fall/drop: ISO 4180-s, NSTA 1A

Vibration: IEC 68-2-6/34

Shock/bump: IEC 68-2-27/29

Physical specifications

Height: 1.050 inches

Width: 12.968 inches

Depth: 10.950 inches

Weight (single module): 3.12 lbs.

Performance specifications (64-byte packets) 

Mean time between failure 
(MTBF)

150,000 hours

Frame length: 64 to 1750 octets 

Interface options

RJ-45 (8-pin modular) connectors for MDI-X interface 

Safety agency approvals UL Listed (UL 1950)

CUL CSA 22.2 No. 950

IEC 950/EN 60950

CE mark

CB Scheme Test Report and Certification

NOM (NOM-019-SCFI-1994)
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Electromagnetic 
emissions

Meets requirements of: US: FCC, CFR 47, Part 15, Subpart B, Class A

Canada: ICES-003, Issue-2, Class A

Australia/New Zealand: AS/NZS 3548:1995, Class A

Japan: VCCI V-3/97.04, Class A

Taiwan: CNS 13438,Class A

EN 55 022:1998/CISPR22:1997 

CE Mark

Electromagnetic 
immunity

Electromagnetic Immunity: EN55024:1998/CISPR24:1997
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